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Using This Manual

This User Manual is divided into three main sections: Getting 
Started, Learning 3D Flag and References. Depending on what 
you need, you’ll find the answers in one of these three sections. 
Read below for more information regarding each section.

Getting Started

If this is the first time you are installing the 3D Flag plug-in, these 
chapters will provide step-by-step instructions on how to prop-
erly install the plug-in.

Learning 3D Flag

You can read the chapters in this section to learn how to use the 
3D Flag plug-in.

The Quick Start chapter will teach you the minimum steps 
needed to create a flag animation. You’ll then learn the details of 
coloring and sizing your flag in Creating A Flag. You’ll then learn 
how to use Wind And Gravity to make your flag move. In Chang-
ing Flag Attributes, you’ll learn how to modify flag parameters to 
achieve the customized flag that fits your needs.

A flag wouldn’t be very useful if you couldn’t place it in your After 
Effects scene. The Flagpoles chapter will show you how to attach 
your flag to an After Effects 3D layer and animate it. The chapter 
on Self-Intersection will demonstrate how you can improve the 
realism of the flag.

Once you’ve mastered the basics, the Working With Multiple Flags 
chapter will teach you how to put multiple flags in a single scene. 
It will also demonstrate how to quickly and easily reuse a single 
flag animation with multiple flag images. Finally, Other Creative 
Uses For Flags will show you how to create more than just flags 
with the 3D Flag cloth engine.

References

As you learn to use the 3D Flag plug-in, you will likely want to 
learn more about certain parameters or features. This section of 
the manual will discuss in detail the parameters you’ll see in the 
After Effects Effect Controls Window as well as the Flag Options 
Window. If you don’t understand a particular parameter, or would 
like to know how something is calculated, these chapters will 
provide insight.
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Installation

Macintosh

Minimum System Requirements
	 • 	G3 Power Mac (G4 or G5 recommended).
	 • 	Mac OS 9.2.2, OS X 10.3.8
	 • 	Apple’s OpenGL system extension.
	 • 	Quicktime 5 or 6.
	 • 	High Res Color Monitor (Millions of Colors).
	 • 	128 MB RAM (256 MB recommended).
	 • 	30 MB unused hard-disk space.
	 • 	CD-ROM drive.
	 • 	Adobe After Effects 5.5 or above.
	 • 	Additional requirements of the host application

Software specifications subject to change without notice. Soft-
ware used under license.
 ALL RIGHTS RESERVED. Refer to the Zaxwerks End User Li-
cense for more information.

Installing the Software In After Effects

The 3D Flag software consists of a plug-in and support files. All 
parts are required for the software to run correctly.
	 1 	Insert the application CD and open it, or decompress the 
archive you downloaded.

 The disk or download archive you received contains a main 
folder with the words 3D Flag in the title. Double-click on this 
folder to open it.

 Inside the window that opens you will find a folder called 3D 
Flag - AE. Inside this folder is the 3D Flag AE plug-in and several 
support files and folders. The 3D Flag - AE folder will be used in 
the next step.
	 2 	Find and open the Plug-ins folder inside the Adobe After Ef-
fects folder. Drag or copy the 3D Flag - AE  folder from its current 
location, into the Plug-ins folder.

WARNING: Do not move these folders individually! Only drag the 
3D Flag - AE  folder. This will copy all the required files into the 
appropriate location on your hard drive. If you drag only the plug-
in into the Plug-ins folder, you will be missing a few important 
support files.

You are now ready to launch After Effects and create your first 
flag.

Authorization In After Effects

The first time you choose 3D Flag from the Effect menu it will ask 
you to enter your Authorization code.

Enter the Name and Organization, and type the code exactly as it 
was given to you. Then press the OK button.

If you click the Demo or Cancel buttons, you will have to re-
launch After Effects before it will give you the Authorization 
window again.
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Windows

Minimum System Requirements
	 • 	Intel Pentium II, III, or 4 processor.
	 • 	Microsoft Windows 2000 or Windows XP.
	 • 	The OpenGL system .dll file.
	 • 	High Res Color Monitor set to True Color.
 (OpenGL accelerator card recommended)
	 •	  128 MB RAM (256 MB recommended).
	 • 	30 MB unused hard-disk space.
	 • 	CD-ROM drive.
	 • 	Adobe After Effects 5.5, 6.0 or 6.5.

Software specifications subject to change without notice. Soft-
ware used under license.
 ALL RIGHTS RESERVED. Refer to the Zaxwerks End User Li-
cense for more information.

Installing the Software In After Effects

The 3D Flag software consists of a plug-in and support files. All 
parts are required for the software to run correctly.
	 1 	Insert the application CD and open it, or decompress the 
archive you downloaded.

 The disk or download archive you received contains a main 
folder with the words 3D Flag in the title. Double-click on this 
folder to open it.

 Inside the window that opens you will find a folder called 3D 
Flag - AE. Inside this folder is the 3D Flag AE plug-in and several 
support files and folders. The 3D Flag - AE folder will be used in 
the next step.
	 2 	Find and open the Plug-ins folder inside the Adobe After Ef-
fects folder. Drag or copy the 3D Flag - AE  folder from its current 
location, into the Plug-ins folder.

WARNING: Do not move these folders individually! Only drag the 
3D Flag - AE  folder. This will copy all the required files into the 
appropriate location on your hard drive. If you drag only the plug-
in into the Plug-ins folder, you will be missing a few important 
support files.

NOTE: 3D Flag requires OpenGL to run. OpenGL is a system 
extension (opengl32.dll) that comes with your Windows operating 
system. If you try to run 3D Flag and get an error saying OpenGL 
is missing, reinstall it from your System CD or download it from 
the Microsoft Downloads Center.

You are now ready to launch After Effects and create your first 
flag.

Authorization In After Effects

The first time you choose 3D Flag from the Effect menu it will ask 
you to enter your Authorization code.

Enter the Name and Organization, and type the code exactly as it 
was given to you. Then press the OK button.
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If you click the Demo or Cancel buttons, you will have to re-
launch After Effects before it will give you the Authorization 
window again.

TROUBLESHOOTING TIP
 On some systems running Windows XP, you will not be able to 
type any more than 2 or 3 characters per field. If this happens to 
you, type the information into Note Pad and then copy each line 
and paste it into the appropriate field.

Quick Start - Creating Your First Flag

Quick Start

Overview

This chapter describes the steps needed to create a basic 3D Flag 
animation.

Each chapter in “Learning 3D Flag” relies on your ability to create 
the basic animation described below, so learn this section first.

A working knowledge of your host program is required to use this 
plug-in, so familiarize yourself with After Effects Comps, layers, 
cameras, and lights before continuing. An understanding of the 
3D animation system in After Effects will help you fully access 
the capabilities of this plug-in, although it is not required.

What’s Needed

The 3D Flag plug-in creates its own 3D space. If you are work-
ing inside of After Effects there is no need to create cameras and 
lights, although there is the option to use them if you want. If you 
are in any other host you won’t have 3D support any way so there 
won’t be a need to concern yourself.

The plug-in effect is applied to a Solid, Color Matte or Video Layer 
that is the same size (and with the same pixel aspect ratio) as the 
Comp or main Monitor Window.

The plug-in will turn the layer it is applied to into a flag, or it can 
use another layer’s image to set the color and size of the flag.

Setting Up The Comp

To create a basic 3D Flag composition, do the following:
	 1 	Create a 640x480 Comp (use Preset: “NTSC, 640x480”). Set 
the duration to 10 seconds. Name the Comp “Flag.”

	 2 	Import the image called “Red Cross.jpg” found in the “Tuto-
rial Images” folder within the “Flag Tutorials” folder. This image 
will be used to determine the color and size of the flag.

	 3 	Drag the image into the Comp and then turn OFF the visibil-
ity switch.

	 4 	Create a 3D camera using the menu option Layer> New> 
Camera. Click OK to accept the default settings.
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ATTENTION AE 6.0 USERS:
	 The 3D camera should have the following attributes:
	 Zoom: 900
	 Film Size: 113.39
	 Angle of View: 39.15
	 Focal Length: 159.4

Additionally, the Position of the camera should be: 320, 240, -900.
	 5 	Create a 3D light using the menu option Layer> New> Light. 
Make the Light Type “Parallel” and click OK.
	 6 	Create a Solid using the menu option Layer> New> Solid. 
Name the Solid “My First Flag.”

IMPORTANT: The Solid containing the 3D Flag effect should have 
the same size and pixel aspect ratio as the Comp. Use the “Make 
Comp Size” button in the Solid Footage Settings dialog.

NOTE: Do not make this layer a 3D layer. The image created by 
the 3D Flag plug-in will look 3D even though the effect is applied 
to a 2D layer.

Adding The Flag Effect
	 1 	Select the “My First Flag” Solid.
	 2 	Add the 3D Flag effect to the “My First Flag” Solid by select-
ing Effect> Zaxwerks> 3D Flag. Do not add the effect to “Red 
Cross.jpg” image.

 At this point, the “My First Flag” layer has turned into a flag, as if 
the layer suddenly went limp like cloth.

 Notice that the color of the flag is the same color as the Solid. 
While it’s possible to create flags this way, we recommend taking 
an additional step in order to better choose how the flag is col-
ored and sized.
	 3 	In the Effect Controls window (ECW), find the Color From 
Layer control and choose “Red Cross.jpg” from the menu.

 The image on the flag becomes the layer you just chose. Notice 
that the size of the flag has changed to be the same size as the 
layer you just chose.

At this point, you should have a basic flag animation ready for 
customization. Save this scene as a starting point for the Learning 
3D Flag chapters in the next section.

An example project called “Quick Start.aep” exists in the Tutori-
als folder. You may use this file when learning each chapter.

Click OK to add the Solid to the Comp.Click OK to add the Solid to the Comp.
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Viewing the Flag Animation

The 3D Flag plug-in can display your animation in real-time 
without needing to do a RAM preview. This is done within the 3D 
Flag Options window. To view the animation in real-time, do the 
following:

	 1 	Click on the 3D Flag logo at the top of the Effect Controls 
window.

	 2 	The 3D Flag Options window will be displayed, showing the 
flag animation in real-time.

	 3 	Notice how the flag seems to be blowing in the wind.
	 4 	Click the OK button to close the window.

For now, just remember that you can get a real-time preview of 
your animation in the 3D Flag Options window. When changing 
parameter values in the Effect Controls window, it’s helpful to see 
quick results using this preview window.

The 3D Flag Options window, and all of its parameters will be 
discussed in more detail in the chapter called Changing Flag At-
tributes.

Match The Comp Size!

The 3D Flag effect must be applied to a Solid that has the same 
size and pixel aspect ratio of the Comp. If not, then a variety of 
bad things can happen.

In the above image, the 3D Flag effect was applied to a layer that 
was smaller than the Comp. Therefore, the resulting flag image 
gets clipped by the layer’s bounds. There are other ways to make 
a flag smaller. See the Resizing A Flag section in the Creating a 
Flag chapter for an example.

Coloring The Flag

Overview

This section describes how to set the color of your flag.

This section assumes that you have read the Quick Start chapter 
and can create a Comp with a 3D Flag in it.
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The Flag Color Comes From A Layer

When the 3D Flag effect is initially applied to a layer, the contents 
of that layer is used to color the flag. Therefore, if you apply the 
3D Flag effect to a blue Solid, the flag will be blue. If you apply 
the 3D Flag effect to an image or a video clip, that image or video 
will show up on the flag.

While you can certainly use the layer you have applied the effect 
to, to color your flag, the 3D Flag plug-in allows you to select any 
layer to use as your flag image. The advantage of this is that you 
can do multiple versions of the same flag animation simply by 
switching the layer that the color is coming from.

For instance, you can apply the flag to a static layer such as a 
Solid or a Color Matte and then take the color from a separate 
source layer. When it is time to change the color of the flag just 
pick the new layer from the Color From Layer menu.

Selecting A Flag Image Layer

The parameter called Color From Layer is used to set the color of 
the flag.

In the Quick Start chapter, we created a project with the Red 
Cross flag. When we first applied the 3D Flag effect, we had a flag 
with a solid color.

It wasn’t until we used the Color From Layer parameter that the 
flag started to have some character.

By coloring the flag with an image, you’ll have more control over 
how the flag looks.

In the next section, Automatically Resizing A Flag, we’ll learn 
how choosing a different color layer can change the flag color 
and size.

Getting Effects To Appear In The Flag Image

There will be occasions when you’ll want to select a color layer 
that includes effects or masks. You’ll probably find that the ef-
fects and masks do not appear on the flag.

To get around this limitation, pre-compose the layer, transferring 
all settings to the new Comp.

Here is an example project demonstrating the need for pre-com-
posing:

Show The Color Layer

	 1 	Open the “Quick Start.aep” project.
	 2 	Turn off the visibility of the “My First Flag” layer and turn on 
the visibility of the “Red Cross.jpg” layer.
 The visibility settings of the two layers should look like the im-
age below.

	 3 	You should now see the “Red Cross.jpg” image in the Comp 
window.
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Apply Effects

	 1 	Apply an effect to this layer. Select the “Red Cross.jpg” layer 
and apply the effect Effect> Stylize> Brush Strokes.
	 2 	The Comp window should now show the image with the ef-
fect applied.

	 3 	Now turn off the visibility of the “Red Cross.jpg” layer and 
turn on the visibility of the “My First Flag” layer again.

 You would expect to see the “Brush Strokes” effect applied to 
our flag image, but instead, nothing has changed.

 This is because effects and masks applied to the color layer are 
not available to the 3D Flag plug-in. To get around this limitation, 
pre-compose the layer.

Pre-Compose The Layer That Has Effects

	 1 	Select the “Red Cross.jpg” layer.
	 2 	Then, from the Layer menu, select the “Pre-compose...” 
command (Layer> Pre-compose). The Pre-compose dialog will be 
displayed.
	 3 	Name the new Comp “Red Cross Pre-Comp” and select the 
“Move all attributes into the new composition” option.

 A new Comp called “Red Cross Pre-Comp” will be created, re-
placing the “Red Cross.jpg” layer.

Resizing The Pre-Comp

The pre-compose operation creates a Comp that has the same 
size as the “Flag” Comp (640x480). We want the “Red Cross Pre-
Comp” Comp to be the same size as the flag image (400x266). 
Let’s fix that now.
	 1 	Open the “Red Cross Pre-Comp” Comp.
	 2 	Open the Composition Settings dialog (Composition> Com-
position Settings).
	 3 	We want our Comp size to match the size of the flag, so set 
the Comp Width to 400 and the Comp Height to 266.
	 4 	Accept the changes and close the window by pressing the 
OK button.

Updating The Flag

Now that we’ve changed the flag’s color layer, we’ll need to up-
date the flag by re-selecting the color layer. This step is necessary 
so that the plug-in properly rebuilds the flag object.
	 1 	Open the “Flag” Comp again.
	 2 	Select the “My First Flag” layer.
	 3 	Open the Effect Controls window (Effect> Effect Controls).
	 4 	Find the Color From Layer menu and select “None.” This 
will reset the color layer back to the color of the Solid. Now that 
we’ve changed it, we can change it back.
	 5 	From the Color From Layer menu, select “Red Cross Pre-
Comp.” The Brush Strokes effect now appears properly on the 
flag and the flag is properly sized.

An example file demonstrating this technique called “Pre-Comp 
Effects.aep” is in the Tutorials folder.

Click the OK button and let After Effects work its magic.Click the OK button and let After Effects work its magic.
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Automatically Resizing A Flag

Overview

This section shows how changing the flag’s color can also change 
the flag’s shape and size.

Changing The Flag Image

In the Quick Start chapter, we created a project with the Red 
Cross flag. Let’s open that project and change the flag image.
	 1 	Open the “Quick Start.aep” project.
	 2 	Import the file called “United Kingdom.jpg” in the “Tutorial 
Images” folder. This is an image of the British flag.
	 3 	Add the “United Kingdom.jpg” image to the Comp and turn 
off its visibility.

	 4 	Open the Effect Controls window (Effect> Effect Controls).
	 5 	Locate the Color From Layer menu and select “United King-
dom.jpg.”

Your Comp window should now look like the image below.

Notice how, when the new image was selected, not only did the 
flag color change, but the size of the flag changed too. The British 
flag has a different aspect ratio than the Red Cross flag. It is wider 
than the Red Cross flag. The 3D Flag plug-in automatically adjusts 
the size of the flag to compensate for this.

The Size From Parameter

With the default settings, the layer you choose for the color will 
also dictate the size of the flag. This is because the Size From pa-
rameter is set to “Color Layer,” meaning the size of the flag comes 
from the same layer that the color comes from.

This is very convenient. Big images make big flags. Small images 
make small flags. Also, when choosing different flag images, the 
shape of the flag will automatically adjust so that the flag has the 
correct proportions.

There will be times, however, when you want more control over 
the size of the flag. The next section, Manually Resizing a Flag, 
discusses how to choose your own flag size.
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Manually Resizing A Flag

Overview

As you use the 3D Flag plug-in, you’ll likely find a situation where 
the flag’s color layer should not dictate the flag’s size. For in-
stance, if you have to create 10 identical animations, but your 10 
flag images are all different sizes, you wouldn’t want the flag to 
change size as you selected each image. The Width and Height 
parameters allow you to set the size of the flag, no matter what 
the size or shape of the flag’s color layer is.

Setting Width And Height

You’ll notice that by default the Width and Height parameters 
are grayed out. This is because the Size From parameter is set to 
“Color Layer.” Let’s change that. As always, we’ll start with our 
Quick Start project.
	 1 	Open the “Quick Start.aep” project.
	 2 	In the Effect Controls window, locate the Size From param-
eter and select “Width and Height” from the menu.

 The Width and Height parameters become dark. Notice that the 
Width and Height parameters are already set to the color layer’s 
size (in this case, 400x266).

 Let’s make this flag half its current size.
	 3 	Since the current width is 400, we’ll want to change it to 200. 
Find the Width parameter and change it to 200.
	 4 	Notice how the flag adjusts to a size of 200x266, almost mak-
ing a square flag.

You have a lot of freedom when setting your flag size.
	 5 	Since the current height is 266, make it half the size by set-
ting Height to 133.

 This makes the flag 200x133, half its original size. Ok, it’s really a 
quarter of its original size, but you know what I mean.

The flag looks like it’s farther away from the camera, but it’s really 
just smaller.

Now that you can set the color, shape and size of your flag, 
let’s learn how to lock different corners and edges of the flag to 
achieve different looks. The next section, Locking Points - Mak-
ing A Hanging Banner, demonstrates how to change a waving flag 
into a hanging banner.
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Locking Points - Making A Hanging Banner

Overview

By default, a 3D Flag is locked in three places: the top left corner, 
the bottom left corner, and the left center point. The rest of the 
flag is free to react to the forces in the scene (that is, flap).

You may change which points on the flag are locked by changing 
the Lock Edges and Lock Points parameters.

Making a Hanging Banner

In this section, we’ll demonstrate how to change which points on 
a flag are locked. Starting with our Quick Start file, let’s make a 
hanging banner with a just a few clicks.
	 1 	Open the “Quick Start.aep” project.
	 2 	Our flag is currently locked on the left side. Since we want 
this banner to hang vertically, we’ll want to lock the top edge.

 In the Effect Controls window, find the Lock Edges parameter 
and select “Top.”

Notice how the wind blows the flag differently when the flag is 
locked at its top points.
	 3 	We’d like to imagine this banner held just by the corners, so 
locate the Lock Points menu and select “Corners Only.”

	 4 	At this point, the flag held in the right places, but the default 
wind speed is too fast. To settle things down, lower the Wind 
Speed vlaue until the flag doesn’t look like it’s being affected too 
much by the wind. A Wind Speed of 1 should do the trick. We’ll 
discuss wind in more detail in the next chapter.

 We let the wind blow very softly, and let gravity do most of the 
work.

By hanging the banner from just the two top corners, we get a 
nice drooping in the center. Watch the animation in the 3D Flag 
Options window to see how the slower wind speed affects the 
banner.

Read below for more information on locking edges and points, or 
continue on to the next section on Creating A Pennant, where we 
show you how to create a flag with non-rectangular shape.

Caption TextCaption Text
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Lock Edges

You can choose which edges are affected by the Lock Points 
parameter by setting the Lock Edges parameter.

You may choose a single edge, or a combination of edges.

Lock Points

For the selected locked edges, you may choose which points 
along those edges are locked.

Besides “None,” you have the four choices shown in the image 
above.

Creating A Pennant

Overview

So far, we’ve seen how to make rectangular flags, but the 3D 
Flag software can make flags of any shape, such as pennants 
and streamers. It can also create curved flags and even flags with 
holes and cut-outs. All of this magic is done by adding an alpha 
channel to your color layer. In this section, we’ll show you how to 
create a pennant.

Preparing The Flag

In order to make a non-rectangular flag, the flag image must be 
created with an alpha channel. This is a fourth channel, in addi-
tion to the red, green, and blue channels, that specifies where the 
transparent areas exist.

There are many ways to create an image with an alpha channel, 
even within After Effects, but this example uses an image created 
in Adobe Photoshop.

To see what an alpha channel looks like, do the following:
	 1 	Open the “Pennant.psd” file in Photoshop. This file can be 
found in the “Tutorial Images” folder located inside of the “Flag 
Tutorials” folder. If you don’t have Photoshop, just read this sec-
tion. You’ll see what you need to see here.
	 2 	The image should look like the picture below.

	 3 	Where is the transparency? At this point Photoshop is only 
showing you the RGB color. To see the alpha channel, open the 
“Channels” palette (Window> Channels).

	 4 	Click on the “Alpha 1” channel. The image changes to show 
the alpha channel for the image.

The white area represents where you will see the flag. The flag 
will not be visible in the black areas. By drawing on the alpha 
channel you can create a flag of any shape.

Left Right Top Bottom

Flag Edges

Left Right Top Bottom

Flag Edges

Lock Points

All Edge 
Points Corners Only

Corners & 
One Center

Corners & 
Two Centers

Lock Points

All Edge 
Points Corners Only

Corners & 
One Center

Corners & 
Two Centers
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Making The Pennant

Creating a non-rectangular flag is as simple as choosing a layer 
that has black in the alpha channel.
	 1 	Open the “Quick Start.aep” project.
	 2 	Set the background color of the Comp to medium gray. 
Select Composition> Background Color and then use the color 
picker to select a medium gray color.
	 3 	Import the image called “Pennant.psd” found in the “Tutorial 
Images” folder within the “Flag Tutorials” folder. This is the same 
image you looked at in Photoshop.
	 4 	Add the image to the Comp and turn off the visibility.
	 5 	In the Effect Controls window, find the Color From Layer 
menu and select “Pennant.psd.”

 Your flag will change into a pennant.

Choosing The Right Quality Setting
	 1 	When the Layer Quality switch is on the Draft setting, the 
alpha channel affects the color of the flag but not the shape.

	 2 	Set the layer Quality switch for the “My First Flag” layer to 
Best quality.

	 3 	The black parts will disappear and you will have a perfect 
pennant.

The next chapter on Wind and Gravity will discuss how to use 
forces to make your flag wave in different directions.

Wind and Gravity - Use the Force

 The motion of a flag is what gives it character.
 This chapter discusses the forces that give a flag its motion.
 The parameters in the Forces section of the Effect Controls 
 window, let you craft your flag to make it look
 like it’s naturally reacting to wind and gravity.

This chapter will require you to view the flag animation
 once parameters have been changed. Be sure to familiarize
 yourself with how to view the flag animation in real-time in the
3D Flag Options window.

	 • 	The Need For (Wind) Speed 
	 • 	Instant Billowing & Gusting 
	 • 	Changing The Wind Direction 
	 • 	How To Animate Wind Direction 
	 • 	Earth Or Moon: Gravity And Slow Motion 
	 • 	Turning A Flat Card Into A Flag
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The Need For (Wind) Speed

Overview

This section will show you how the Wind Speed parameter affects 
a flag’s motion.

This section assumes that you have read the Quick Start chapter 
and can create a Comp with a 3D Flag in it.

Making A Light Breeze

The 3D Flag plug-in has a default Wind Speed of 11. This speed 
causes the flag to flap at a good rate. There will be times when a 
slower breeze is more appropriate for your scene.

To slow the pace down, do the following:
	 1 	Open the “Quick Start.aep” project.
	 2 	In the Effect Controls window, find the Wind Speed param-
eter. Lower the speed value until the flag is drooping at about a 45 
degree angle. A value of 5 should work.

 Notice how the flag droops. Since less wind is being applied to 
the cloth flag, gravity has more effect.
	 3 	To see the results of this change in real-time, open the Op-
tions window by clicking on the 3D Flag logo in the Effect Con-
trols window.

	 4	 When you’re done watching the flag, click the OK button to 
close the Options window.

By animating the Wind Speed value you can get the flag to dance. 
Quick changes in wind speed make the flag lift and fall.

How Wind Affects The Flag

Wind does not affect all parts of the flag equally. Those portions 
of the flag that face the wind (towards or away) will be blown 
more strongly than the portions of the flag parallel to it.

This is one of the reasons flags undulate in the wind. Portions 
that face the wind are blown to the side. This flattens out the part 
that was facing the wind and causes the next section of the flag 
to bend. This flattening and bending cycle continues down the 
length of the flag creating a wave.

The diagram below shows how wind affects the flag, depending 
on how directly the flag is facing the wind.

In the next section, Instant Billowing & Gusting, you’ll learn how 
to quickly create animated wind to give the flag some great-look-
ing character.
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Instant Billowing & Gusting

Overview

If you leave the Wind Speed set to a constant speed the flag’s ani-
mation will start to look repetitive. To make things more interest-
ing, 3D Flag has a built-in wind pattern generator.

The wind pattern generator will automatically create keyframes 
for the Wind Speed parameter. This allows you to quickly cre-
ate varying wind speeds, making your flag animation look much 
better. You access the wind pattern generator by picking a preset 
from the Speed Presets menu.

Creating Gusts

The wind pattern generator is really quite amazing. With it you 
can create everything from calm breezes to near-hurricane type 
forces. You should take some time to see what each setting does. 
For this particular example we will create a gusting style of wind.
	 1	  Open the “Quick Start.aep” project.
2. In the Effect Controls window, locate the Speed Presets menu 
and select “Gusty - Variable.”

This will cause any existing Wind Speed keyframes to get cleared, 
and dozens of new ones to be created. Way more keyframes than 
you would want to create by hand!
	 3 	Open the Wind Speed animation graph in the Timeline win-
dow to see how the wind is no longer constant.

 Your animation will look different than the image above because 
the wind pattern generator uses random numbers when generat-
ing keyframes.

You may edit these keyframes as you would any animation graph, 
or you may generate a new set of keyframes by selecting another 
preset from the Speed Presets parameter. You can even select the 
same preset over and over to create different random variations 
of the same wind style.
	 4 	To see how the wind now affects the flag, view the new 
animation within the Options window by clicking on the 3D Flag 
logo.

	 5 	When you’re done watching the flag, click the OK button to 
close the Options window.

Clearing Keyframes

Now that you’ve automatically created Wind Speed keyframes, 
you can clear the keyframes with one command.
	 1 	In the Speed Presets menu, select “Clear Keyframes.”

 All of the keyframes for the Wind Speed parameter are deleted 
and the Wind Speed is set back to the default value of 11.0.

So far, the wind has been blowing to the right. Let’s learn how to 
change that in the next section, Using Wind Direction Presets.

Caption TextCaption Text
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Changing The Wind Direction

Overview

So far, we’ve only seen the wind blow to the right. This section 
will discuss how to change the wind direction by using the Direc-
tion Presets menu.

Using Wind Direction Presets

The 3D Flag plug-in comes with several wind Direction Presets. 
You can use the presets to quickly choose different wind direc-
tions.

NOTE: The direction presets do not cause the wind to blow in 
absolute directions. That is, a “Right” blowing wind also blows a 
little to the back and a little up. This allows the wind to act more 
naturally within the scene. Absolute angles don’t always provide 
the best looking wind.

In this example, you’ll learn how to change the wind direction 
from the default of “Right” (wind blowing toward the right) to 
“Back” (wind blowing toward the back).
	 1 	Open the “Quick Start.aep” project.
	 2 	In the Effect Controls window, find the Direction Presets 
menu and select “Back.”

 This will change the Wind Dir Angle and Wind Dir Elevation pa-
rameters, making the wind blow towards the back of the scene.
	 3 	To see how the wind direction now affects the flag, open the 
Options window by clicking the 3D Flag logo.

	 4 	When you’re done watching the flag, click the OK button to 
close the Options window.

While you can manually set the Wind Dir Angle and Wind Dir 
Elevation parameters, as you’ll see in the next section, How To 
Animate Wind Direction, the Direction Presets menu gives you 
easy access to common wind directions.

How To Animate Wind Direction

Overview

The 3D Flag plug-in uses two parameters to determine the wind 
direction: Wind Dir Angle and Wind Dir Elevation. We’ll show 
how these two values specify a direction. We’ll also discuss ways 
to animate a changing wind direction.
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How Wind Direction Is Calculated

Wind Dir Angle and Wind Dir Elevation are two angle values that 
3D Flag uses to calculate the wind direction.

You can imagine Wind Dir Angle representing a rotation from 
the left to right. Wind Dir Elevation represents a rotation up and 
down.

Both angles are in degrees.

The image below shows how the Wind Dir Angle parameter 
goes from 0 degrees to 360 degrees. This parameter determines 
whether the wind blows to the left, to the right, towards the back 
of the scene, or towards the front of the scene.

Imagine standing with your arm pointed straight ahead. That’s 
0 degrees (Back). As you rotate your arm and body to the right, 
you’ll get to 90 degrees (Right). Keep going and you’ll have turned 
around 180 degrees (Forward). Continuing around, you’ll hit 270 
degrees (Left) before getting back to 0 degrees (which is also 360 
degrees).

The next image shows how Wind Dir Elevation can raise the wind 
direction towards the sky or lower it towards the ground.

Imagine standing with your arm pointed at the horizon. That’s 0 
degrees (no elevation). As you raise your arm, you increase eleva-
tion in the positive direction. You’ll eventually point straight up, 
90 degrees (Up). As you lower your arm, elevation get more and 
more negative. You’ll eventually point straight down, -90 degrees 
(Down).

Using these two values, you can make your wind point in any 
direction.

Animating Wind Direction

Let’s make our flag rotate all the way around, starting to the right, 
and rotating clockwise.
	 1 	Open the “Quick Start.aep” project.
	 2 	In the Effect Controls window, find the Wind Dir Angle pa-
rameter. Turn on keyframing for that parameterby clicking on the 
stopwatch icon next to the parameter name.

This sets a keyframe at time 0:00, with a value of 85.

NOTE: Remember in the last section when we told you that the 
Direction Presets did not use absolute directions? That’s why 
the Wind Dir Angle is 85 and not 90. 0, 90, 180, and 270 would be 
absolute directions. 85 is just a little off.
	 3 	Now move the time marker to 4 seconds, time 4:00.

	 4 	We want our flag to rotate once around. Click on the Wind 
Dir Angle value and drag to the right.

 As the angle increases, you’ll see the flag rotating around its fixed 
points in a clockwise direction. Once the flag has made it back to 
the right, let go of the mouse button.

Wind Dir AngleWind Dir Angle

Wind Dir ElevationWind Dir Elevation
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 The Wind Dir Angle should be about 445, which is one full rota-
tion: 85 degrees + 360 degrees. Another keyframe is created at 
time 4:00 since we changed the parameter value.
	 5 	To watch the flag rotate around its locked points, open the 
Options window by clicking the 3D Flag logo in the Effect Con-
trols window.

	 6 	When you’re done watching the flag, click the OK button to 
close the Options window.

Now that we’ve seen how wind affects the flag, let’s learn about 
gravity in the next section, Earth Or Moon: Gravity And Slow Mo-
tion.

Earth Or Moon: Gravity And Slow Motion

Overview

Newton told us about gravity. We learned that an apple falls at the 
same rate as a grape. We also learned that objects accelerate as 
they fall. And we were taught that objects fell at about 9.8 m/s^2.

This section discusses how 3D Flag uses gravity to make a flag 
drop naturally, and how we can set gravity to a value other than 
9.8 to simulate other environments, like being on the moon, or 
under water.

The Pull Of Gravity

The flags that 3D Flag creates are made up of a grid of points. 
Each point has a weight (a mass), and gravity pulls each point 
downward using the standard gravity equation mentioned above.

Gravity is different than wind speed because wind affects each 
point on the flag differently. Gravity, by contrast, affects each 
point on the flag equally.

So, while wind is blowing the flag in one direction, gravity is tug-
ging it down. The two forces work together to create a natural 
look.

Putting A Flag On The Moon

As you may know, the moon doesn’t have as much gravity as the 
earth. Astronauts float as they leap from point to point. In fact, 
the moon has only 1/6 of the gravity of earth, so objects only fall 
about 1.6 m/s^2.

We can simulate a flag on the moon by setting Gravity to 1.6 and 
by slowing down our Wind Speed.
	 1 	Open the “Moon.aep” project found in the “Flag Tutorials” 
folder. This project has a United States flag in it. We’ll change our 
forces to make it look like the flag is on the moon, similar to the 
image above.
	 2 	Since we’re putting this flag on the moon, we’ll need to 
change the amount of gravity in the scene. In the Effect Controls 
window, locate the Gravity parameter and change its value to 1.6. 
The gravity in the scene is now 1/6 of what it used to be.
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 The flag doesn’t change that much because the wind was already 
blowing pretty strong to the right.
	 3 	Since the moon doesn’t really have wind, but does have 
some small wind-like force, let’s slow our Wind Speed way down, 
making it blow just enough to keep the flag upright.

 In the Effect Controls window, find the Wind Speed parameter 
and lower its value until just before the flag starts to droop. A 
value of 2 should look about right.
	 4 	Watch the new animation by clicking the 3D Flag logo, in the 
Effect Controls window, to open the Options window.

 Notice how everything seems slower. The wind is very slow, but 
the gravity is low too, so the flag stays up.
	 5 	Click the OK button to exit the Options window.

Slow Motion

Let’s go one step further and find out how to put a flag into slow 
motion. We’ll use the same principals discussed above. We’ll 
lower Wind Speed and Gravity, making sure that the gravity is 
really low, and that the wind speed is just fast enough for the flag 
to keep its shape.
	 1 	Locate the Gravity parameter and lower it way down, setting 
it to around 0.2. This gravity will pull down on the flag just a little 
bit.
	 2 	Now lower the Wind Speed parameter way down. We want 
the wind speed to be as slow as possible, but to allow the flag to 
keeps its shape. A value of 0.5 should work.
	 3 	Now play back the animation in the Options window again. 
Notice how everything moves very slowly. The lower the wind 
speed and gravity, the slower the motion.

You can combine Wind Speed and Gravity to simulate some inter-
esting environments.

There is one remaining Forces parameter that we have not dis-
cussed. In the next section, Using Pre-Roll To Find The Perfect 
Wave, we’ll see how the Pre-Roll parameter can help us start our 
animation at the right moment.

Making A Flat Card Turn Into A Flag

Overview

Here’s an interesting effect. You can start with the image looking 
like a flat card, and then turn it into a flag as the user watches! 
How can you create such magic? It is all a matter of creatively 
using the Pre-Roll feature.

A 3D Flag simulation always starts with the flag in a neutral, flat 
state. That is, before wind , gravity, or anything else can change 
the look of the flag, it begins upright and flat, as shown here.

The reason your never see this state is because the Pre-Roll value 
is set to 4 seconds. This means that the flag simulation runs for 4 
seconds before you ever see the first frame.

By setting the Pre-Roll value to 0 the flag will look like a flat card.
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Creating The Card

Let’s see what happens to our flag if there is no pre-roll. That is, 
let’s see how wind and gravity affect the flag from its default posi-
tion.
	 1 	Open the “Quick Start.aep” project.
	 2 	In the Effect Controls window, locate the Pre-Roll parameter 
and set it to 0.

Notice that the flag is now a flat rectangle, with no forces yet ap-
plied to it.
	 3 	View the animated flag within the 3D Flag Options window 
by clicking on the 3D Flag logo in the Effect Controls window.

Notice how the flag begins to drop due to gravity, but then the 
wind forces it to the right. After a few seconds, the flag settles 
into a nice undulation.
	 4 	While still in the 3D Flag Options window, click the Restart 
Simulation button.

 This will restart the flag animation from the first frame after the 
pre-rolling is done. That is, if Pre-Roll were set to 4 seconds, the 
first frame of the animation playback would be just after 4 pre-
rolled seconds.

In our current example, Pre-Roll is 0 seconds, so restarting the 
animation puts the flag back in its default position. You can watch 
the wind and gravity make the flag undulate again.

Adding More Magic

When you preview the animation in real-time you can see that 
the card turns into a flag pretty fast. To make the transition more 
graceful you should lower the Gravity. Like we learned in the pre-
vious section lowering the gravity keeps the flag from dropping 
so fast. By setting Gravity to a low value such as 1 or even .2, the 
effects of gravity will be minimized and the transition from card 
to flag will be more magical.

By lowering the wind speed the transition will become especially 
slow. If you really want to make it look cool, animate the wind 
speed from 0 up to 11 over a 10 second period. This will cause the 
wind take effect very slowly and then ramp up to a full billow and 
gale.

Sometimes, when animating a “drop effect” such as this, you need 
the fabric of the flag to be more loose and rubbery. This is espe-
cially the case when you are suspending the flag from above like 
you would for a banner.

The next chapter, Changing Flag Attributes, will demonstrate how 
to use the 3D Flag Options window to customize the cloth of your 
flag. The next chapter will show you that not all flags have to look 
the same.
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This chapter demonstrates how to use the 3D Flag Options win-
dow.

 The first few sections will show you how to change your view of 
the
 flag and control the playback of the animation.

 Subsequent sections will give examples of how changing flag 
parameters
 can create different types of flags.

	 • 	Opening The 3D Flag Options Window 
	 • 	Changing Your View Of The Flag 
	 • 	Controlling Animation Playback 
	 • 	Changing The Mesh Density 
	 • 	Choosing Between Right And Left Meshing 
	 • 	Making A Rubbery Flag With Presets 
	 • 	Changing A Flag’s Weight 
	 • 	Understanding Stretch, Bend, And Shear 
	 • 	Get The Wrinkles Out With Conform 
	 • 	Using Air Friction To Slow Things Down 
	 • 	How To Make Flags Look Large

Opening The 3D Flag Options Window

Overview

The 3D Flag Options window serves two purposes:
	 1 	It displays the flag animation in real-time, allowing you to 
control the playback and view the flag from any angle.
	 2 	It contains controls for specific attributes of the flag that you 
can change to shape how the flag reacts to wind and gravity.

Opening The Options Window

To open the Options window, click the 3D Flag logo at the top of 
the Effect Controls window.

The Options window will be displayed.

Read the next section, Changing Your View Of The Flag, for 
instructions on how to rotate the flag and show the flag in wire-
frame mode.

Changing Your View Of The Flag

Overview

The 3D Flag Options window initially displays the flag centered 
on the screen. Depending on the wind and gravity settings, this 
may not hold true over the course of the animation.

This section shows how to change the view in the 3D preview 
window. It also shows how to display the flag in wireframe mode.
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This section refers to the 3D preview window of the 3D Flag Op-
tions window.

The 3D Flag Options window uses OpenGL to display the flag in 
real-time. Depending on your computer’s graphics card, the play-
back may or may not be smooth.

This section also refers to the three display buttons at the top of 
the 3D Flag Options window.

Changing The 3D View

There are three ways to change the view of the flag in the 3D 
preview window:
	 1 	Rotate the flag (Rotate).
	 2 	Move towards or away from the flag (Zoom).
	 3 	Move the flag up, down, left, or right in the view (Pan).

You can do each of these operations by clicking and dragging the 
mouse within the 3D Preview window. Depending on the opera-
tion, you’ll need to hold down a different key while dragging. The 
following chart shows which key controls which operation.

Open the 3D Flag Options window and become familiar with the 
flag view controls by clicking and dragging in the 3D preview 
window while holding down different keys.

Changing The Flag Display Mode

By default, the flag in the 3D preview window is colored by the 
image selected in the After Effects project. This is but one of 
three ways to display the flag in the preview window.

Wireframe Display Mode

To enable Wireframe display mode, click on the Wireframe icon 
above the preview window.

This will display the flag in wireframe mode, showing how the 
flag is constructed out of triangles.

Shaded Display Mode

To enable Shaded display mode, click on the Shaded icon above 
the preview window.

Hold Down Key
Dragging 
Left/Right

Dragging 
Up/Down

<none> Rotates 
Left/Right

Rotates 
Up/Down

Shift <nothing> Zooms In/Out

Command (Mac)
Control (Win)

Moves 
Left/Right

Moves 
Up/Down

Hold Down Key
Dragging 
Left/Right

Dragging 
Up/Down

<none> Rotates 
Left/Right

Rotates 
Up/Down

Shift <nothing> Zooms In/Out

Command (Mac)
Control (Win)

Moves 
Left/Right

Moves 
Up/Down
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This will show the flag in shaded mode -- solid white, and without 
textures.

Textured Display Mode

To enable Textured display mode, click on the Textured icon 
above the preview window.

This will show the flag in textured mode, showing the flag with 
the current color image.

In the next section, Controlling Animation Playback, you’ll learn 
how to start, stop, and step through the animation in the preview 
window.

Controlling Animation Playback

Overview

When the 3D Flag Options window is first displayed, the anima-
tion begins playing. If wind or gravity are animated, their affect 
on the flag is shown.

The orientation of the flag is based on the current position and 
rotation of the flag in the After Effects Comp when the 3D Flag 
Options window is opened. For example, if your Comp is at time 
5 seconds, and your flag is rotated 45 degrees, the flag in the 3D 
Flag Options window will be rotated 45 degrees. We’ll discuss 
ways to move and rotate your flag in the next chapter on Flag-
poles.

This section shows you how to control your flag animation.

You may pause, restart, and step through the animation using 
your keyboard. You may also switch between Real-Time playback 
mode and Frame-By-Frame playback mode.

Playback Is Always 30.0 FPS

The 3D Flag Options window always strives to play the animation 
back at 30.0 frames per second, regardless of the frame rate of 
the After Effects Comp.

Therefore, previewing an animation from a 10 FPS Comp will 
look the same as previewing an animation from a 30 FPS Comp.

If you’d like a more accurate playback of your Comp, you can al-
ways do a RAM Preview (Composition> Preview> RAM Preview), 
or render your project to a movie file.
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Switching Playback Modes

The 3D Flag Options window can play the animation using one of 
two modes:
	 • 	Real-Time Playback Mode
	 • 	Frame-By-Frame Playback Mode

Let’s switch an animation playback from Real-Time mode to 
Frame-By-Frame mode.
	 1 	Open the “Quick Start.aep” project.
	 2 	Open the Options window by clicking the 3D Flag logo in the 
Effect Controls window.

	 3 	Watch the Time field change. By default, it is running in real-
time, so one second of animation is played in one second of real 
time.

	 4 	Now find the playback menu in the upper left corner of the 
Options window. Select “Frame-By-Frame.”

 The animation will restart. Once again, watch the Time field. It 
is no longer updating in real-time. Depending on your computer 
and graphics card, it will either be updating slower or faster than 
real-time. Notice how the flag animation is running at a different 
speed as well.
	 5 	When you’re done watching the flag, click the OK button to 
close the Options window.

With Frame-By-Frame playback, each frame of the 30.0 FPS ani-
mation is displayed, no matter how long it takes to calculate and 
display that frame.

Real-Time Playback Mode

This mode, the default playback mode, will show the animation in 
real-time. That is, one second of animation will be shown within 
one second of real time. If your computer’s CPU or your comput-
er’s graphics card is unable to display the animation at 30.0 FPS, 
frames will be dropped in order to keep the time correct.

Playback may be choppy using this mode, but you’ll be able to see 
how the flag reacts to the forces in the scene as they occur.

Frame-By-Frame Playback Mode

The Frame-By-Frame playback mode does not worry about 
displaying the animation in real-time. It will show each frame (at 
30.0 FPS) as quickly as it can.

This mode is useful to see how every frame of an animation will 
look, so that you can notice subtle details that may be missed if 
frames are dropped in Real-Time mode.
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Controlling Playback

There are 3 keys and one button that can be used to control the 
animation playback: the spacebar, the left arrow key, the right ar-
row key, and the Restart Simulation button.

Spacebar

You may press the spacebar to stop and start the animation at any 
time.

Left Arrow Key

When the animation is paused, pressing the left arrow key will 
step back one frame in time (approximately 0.033 seconds). If 
you hold the Shift key while pressing the left arrow key, the ani-
mation will step back 10 frames.

Right Arrow Key

When the animation is paused, pressing the right arrow key will 
step forward one frame in time (approximately 0.033 seconds). 
If you hold the Shift key while pressing the left arrow key, the 
animation will step forward 10 frames.

Restart Simulation Button

At any time, you may press the Restart Simulation button to start 
the animation at time 0:00. This start time is the first frame after 
pre-rolling.

In the next section, we’ll begin changing flag attributes, starting 
with the flag mesh, in How To Determine The Best Mesh Size.

Changing The Mesh Density

Overview

A flag is a grid, or mesh, of points connected together to create a 
set of triangles.

You can specify how many points are in the mesh by using the 
Horizontal Mesh and Vertical Mesh controls in the 3D Flag Op-
tions window. This section shows you how to change the flag 
mesh density.



Zaxwerks - User Guide 28

Showing The Flag in Wireframe

Changing your flag’s mesh size is done by setting the Horizontal 
Mesh and Vertical Mesh values in the 3D Flag Options window. 
Changing these values do not change the size of the flag.
	 1 	Open the “Quick Start.aep” project.
	 2 	In order to better see the flag’s mesh, you’ll want to view the 
flag in its default position. In the Effect Controls window, find the 
Pre-Roll parameter and set it to 0.
	 3 	Next, open the Options window by clicking the 3D Flag logo 
in the Effect Controls window.

	 4 	Pause the animation by pressing the spacebar.
	 5 	Change the view mode to Wireframe by clicking on the Wire-
frame icon.

Lowering The Mesh Density

Now that we can see our flag in wireframe mode, let’s change our 
mesh density to be much smaller than it is by default.
	 1 	Change the Horizontal Mesh value to 7.

 Notice how the animation pops back to time 0:00, showing the 
flag in its default position. When flag attributes are changed, the 
flag must be rebuilt so that the effect of wind and gravity can be 
recalculated. This is why you set Pre-Roll to 0. When changing 
your mesh density, you can get a good look at how your flag is 
being constructed.
	 2 	Change the Vertical Mesh value to 5.

 Notice how the flag’s size didn’t change. The mesh density only 
affects how many rows and columns there are in the flag. It 
doesn’t affect the size of the flag.

 Your mesh should now look like the image below.

 This mesh is a lot less dense than the default 21x21 mesh. There-
fore, wind and gravity will move it differently than the default 
mesh.
	 3 	Change back to Textured mode.

	 4 	Now play the animation by either clicking the Restart Simu-
lation button or pressing the spacebar.

 Notice how wind and gravity still move the flag, but the resulting 
movement is less dramatic. This is because there are far fewer 
points to be affected by wind and gravity. This flag looks like it’s 
made out of a very stiff material, such as paper.
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Increasing The Mesh Density

Now, let’s make the mesh much more dense.
	 1 	Pause the animation by pressing the spacebar.
	 2 	Turn on Wireframe mode.

	 3 	Change Horizontal Mesh to 31.
	 4 	Change Vertical Mesh to 31.

 Your mesh should now look like the image below.

 Dense, indeed.
	 5 	Now switch back to Textured mode.

	 6 	Play the animation by pressing the spacebar.

 Depending on your computer speed and your graphics card, 
the animation may play back slowly. You may wish to switch to 
Frame-By-Frame mode.

 Notice how this flag contains a lot more detail than the 7x5 mesh. 
It has more folds and looks more grand, as if were made of a very 
loose material, like silk.
	 7 	When you’re done watching the flag, click the OK button to 
close the Options window.

You may have noticed that the flag mesh is made into triangles by 
a diagonal line going from the upper-left corner to the lower-right 
corner of each mesh grid rectangle. In the next section, Choosing 
Between Right and Left Meshing, you’ll learn what factors would 
cause you to change that meshing from “Right” to “Left.”

Choosing Between Right And Left Meshing

Overview

Each mesh grid rectangle is converted into two triangles by con-
necting two opposite corners.

By default, the top-left corner is connected to the bottom-right 
corner. This is called “Right” meshing.

You may also choose “Left” meshing, which connects the upper-
right corner to the lower-left corner.

The two images below show the difference between “Right” 
meshing and “Left” meshing.

Caption TextCaption Text

Right Meshing Left MeshingRight Meshing Left Meshing
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What Bad Meshing Looks Like

The Meshing parameter in the 3D Flag Options window deter-
mines in which direction the flag geometry is created. Choos-
ing the right meshing direction is important, as this section will 
demonstrate.
	 1 	Open the “Quick Start.aep” project.
	 1 	In the Effect Controls window, find the Color From Layer 
parameter and select “None.” This action will remove the “Red 
Cross.jpg” image from the flag and make the flag larger (640x480, 
the size of the layer the 3D Flag plug-in was applied to).
	 2 	Locate the Lock Edges parameter and select “Right.” This 
will cause three of the points on the right side of the flag to be 
locked into place. The left points are no longer locked.

 Where did the flag go? Since the wind is still blowing to the right, 
the flag is blowing off screen. Let’s fix that.
	 3 	From the Direction Presets menu, select “Left.” This will 
make the wind blow to the left, causing the flag to blow back into 
the frame. We now have flag that is locked on the right edge blow-
ing to the left.

 Immediately, we can see a reason why the default “Right” mesh-
ing does not work for this scene.

 The stair-step effect is an artifact of the way the flag mesh is 
built. To fix this, we’ll switch the direction of our meshing.

Fixing Bad Meshing

	 1 	Open the Options window by clicking the 3D Flag logo in the 
Effect Controls window.

 As the animation plays, you can see the bad meshing all over the 
flag.
	 2 	Pause the animation by pressing the spacebar.
	 3 	Locate the Meshing menu and select “Left.” This will change 
how the flag geometry is created, smoothing out the look of the 
flag.
	 4 	Click the OK button accept the change in settings and to exit 
the Options window.

 The “Flag” Comp looks much better now. You now know that a 
left-blowing flag probably needs “Left” meshing.

Choosing The Correct Meshing Direction

As you’ve seen, the meshing direction can dramatically change 
the look of the flag. Depending on which points on the flag are 
locked and which direction the wind is blowing, “Left” meshing 
may look better than “Right” meshing.

NOTE: As a general rule, you should see if you animation looks 
fine with the default meshing. If it doesn’t, try switching the mesh-
ing direction.
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The table below advises which meshing may work best when a 
particular flag edge is locked.

Now that you’ve learned how to change a flag’s mesh settings, we 
will show you how to change other flag parameters. We’ll start 
with Flag Presets in Making A Rubbery Flag With Presets. 

Making A Rubbery Flag With Presets

Overview

Each flag has several parameters that determine how it reacts to 
forces like wind and gravity. These parameters can be changed to 
make a flag stretchy or rigid, loose or stiff.

The 3D Flag plug-in has several presets that will automatically set 
these parameters to create different flag looks. This section will 
show you how to select a Flag Preset.

Making Your Flag Rubbery

The default flag corresponds to a preset called “Stiff Flag.” These 
flag parameters produce a flag that keeps its shape, but will still 
react well to the wind. You can make the flag rubbery by selecting 
the “Rubbery Flag” preset.
	 1 	Open the “Quick Start.aep” project.
	 2 	Open the Options window by clicking the 3D Flag logo in the 
Effect Controls window.

 Notice how the flag reacts to the wind and gravity. It stays up-
right and undulates in the wind.
	 3 	Pause the animation by pressing the spacebar.
	 4 	Locate the Flag Presets menu and select “Rubbery Flag.”

 Selecting a preset will modify the six parameters below the Flag 
Presets menu.

 Notice how the flag is now elongated.

 The “Rubbery” parameters allow certain aspects of the flag to 
stretch more than the default “Stiff Flag.”
	 5 	Now click the Restart Simulation button. As the animation 
plays, notice that the flag stretches and pulls more than you’ve 
seen before.
	 6 	When you’re done watching the flag, click the OK button to 
close the Options window.

There are other Flag Presets that give the flag different looks. 
Each preset will create a flag that will react to wind and gravity in 
a different way.

In the next section, Changing A Flag’s Weight, you’ll learn about 
how a flag’s weight affects how the flag responds to the wind.
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Changing A Flag’s Weight

Overview

The 3D Flag Options window allows you to change a flag’s weight. 
While there is usually little reason to change the weight of the 
flag, it’s good to understand how weight affects the flag anima-
tion.

Weighing Your Options

When modifying a flag’s weight, remember two things:
	 • 	The lighter the flag, the more it reacts to the wind.
	 • 	The heavier the flag, the less it reacts to the wind.

Let’s see how doubling the flag’s weight affects our “Quick Start” 
flag..
	 1 	Open the “Quick Start.aep” project.
	 1 	Open the Options window by clicking the 3D Flag logo in the 
Effect Controls window.

	 2 	Pause the animation by pressing the spacebar.
	 3 	Set Flag Weight to 2. This makes every point on the flag 
twice as heavy.

	 4 	Play the animation by clicking the Restart Simulation button. 
The flag seems to be less upright than before. The wind doesn’t 
affect it as much.
	 5 	When you’re done watching the flag, click the OK button to 
accept the change to the flag’s weight and to close the Options 
window.

You may set a flag’s weight to simulate different cloth materials. 
In the next section, Understanding Stretch, Bend, And Shear, 
we’ll learn about some important flag parameters that will greatly 
affect how a flag reacts to the environment.

Understanding Stretch, Bend, And Shear

Overview

Each flag is created by a series of springs connected to the points 
in the flag mesh. The springs push and pull on each other, allow-
ing wind and gravity to make the mesh look like cloth.

Three of the most important parameters that affect the flag’s 
reaction to the environment are Flag Stretch, Flag Bend, and Flag 
Shear.

The reason these parameters are discussed together is because 
they are parameters that control the springs in the flag mesh.
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Anatomy Of A Flag Mesh

Flags react to the environment because of calculations made to 
the springs that connect mesh points. There are three types of 
springs, and each type of spring can be controlled separately.

The diagram below shows how each spring is constructed.

Stretch Springs

These springs connect adjacent mesh points, horizontally and 
vertically.

Bend Springs

These springs connect every other mesh point, horizontally and 
vertically. Bend Springs overlap each other.

Shear Springs

These springs connect mesh points on the diagonal.

Stretch, Bend, And Shear Parameter Values

The Flag Stretch, Flag Bend, and Flag Shear values range from 
0 to 100. They represent how much each spring can extend, as 
a percentage. The allowed extension is only a goal -- it is not 
guaranteed. As the springs push and pull against each other, some 
springs may end up out of range.

This constant pushing and pulling gives the flag its shape, causing 
undulation and ripples over the surface of the flag.

Small Values Are Highly Effective

You won’t have to set the Flag Stretch, Flag Bend, and Flag Shear 
values very high for them to be effective. In fact, values over 20 
(percent) may create flags that stretch too much to be useful.

Allowing The Flag To Stretch, Bend, and Shear

Let’s see what happens when you change the Flag Stretch, Flag 
Bend, and Flag Shear values to allow the flag to expand up to 20% 
of its size.
	 1 	 Open the “Quick Start.aep” project.
	 1 	Open the Options window by clicking the 3D Flag logo in the 
Effect Controls window.

	 2 	Pause the animation by pressing the spacebar.
	 3 	Find the Flag Stretch, Flag Bend, and Flag Shear parameters 
and set each to 20.
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 You may have to wait while the flag is recalculated after each 
parameter change.

 Notice how the flag is now stretched out.

	 4 	Play the animation by clicking the Restart Simulation button. 
Notice that the flag is pushed and pulled more by the wind and 
gravity.
	 5 	When you’re done watching the flag, click the OK button to 
close the Options window.

You may need to experiment a bit with the spring parameters to 
find values that fit your needs.

We can gain more control over the shape of the flag with the 
Conform parameter. The next section, Get The Wrinkles Out With 
Conform, will discuss this useful parameter.

Get The Wrinkles Out With Conform

Overview

In the last section, we mentioned that Flag Stretch, Flag Bend, 
and Flag Shear percentage values were only goals for the spring 
system. Due to the way the flag simulation works, the springs 
may push and pull each other outside of the desired ranges. The 
Conform parameter can be used to better enforce the goal of the 
spring parameters. That is, it can further constrain the springs to 
create a more accurate system.

A side effect of this constraint is that it will make the flag appear 
more stiff, keeping the flag more upright. This can make the flag 
have less folds while flapping in the wind.

Life Without Conform

The default flag has a Conform value of 7. This mean the spring 
system tries 7 times as hard to make the flag mesh conform to the 
goals of Flag Stretch, Flag Bend, and Flag Shear than if Conform 
were set to 1.

Let’s see what happens when we remove the Conform calcula-
tion.
	 1 	 Open the “Quick Start.aep” project.
	 1 	Open the Options window by clicking the 3D Flag logo in the 
Effect Controls window.

	 2 	Pause the animation by pressing the spacebar.
	 3 	Set Conform to 1. This tells the spring system to not care 
about how out of range the springs are.

 Notice how the flag no longer holds its shape in the wind.
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	 4 	Play the animation by clicking the Restart Simulation button. 
Notice that the stretched areas continue to be pulled. There isn’t 
anything preventing this since Conform is 1.

Setting A High Conform Value

Let’s say we want our flag to be rather stiff. We want the wind to 
blow through the flag, but we don’t want it to be too springy. We 
can set Conform to a high value to achieve this goal.
	 1 	Pause the animation by pressing the spacebar.
	 2 	Change Conform to 20. The system will now try 20 times as 
hard to keep the flag’s shape.
	 3 	Play the animation by clicking the Restart Simulation button. 
The flag now holds its shape much better, allowing little stretch-
ing.

 The real-time playback may be more choppy than when Conform 
was set to 1. This is because calculating each flag frame when 
Conform is 20 requires more effort.
	 4 	When you’re done watching the flag, click the OK button to 
close the Options window.

Usually, Conform values in the range of 1 to 20 are sufficient.

There is one more flag parameter to discuss. The next section, Us-
ing Air Friction To Slow Things Down, will show how to use Air 
Friction to gain more control over your flag’s behavior.

Using Air Friction To Slow Things Down

Overview

We don’t live in a vacuum. Well, I don’t live in a vacuum. And 
this means that, in my world, there are all sorts of particles and 
dynamic forces that cause friction to a flag blowing in the wind. 
Therefore, a flag will never move quite as much as the wind 
would like it to.

The Air Friction parameter can be used to control how the flag re-
acts to the environment (wind, gravity, etc.). With no friction, the 
flag may blow wildly, even with a light wind. With a lot of friction, 
the flag may not respond to wind or gravity very much.

In general a small amount of Air Friction will help keep the flag 
under control.

Removing Friction

The default value for Air Friction is 5 (percent). This means that, 
at each frame, the flag will only undulate about 95% of what wind 
and gravity tell it to.

Let’s see how the flag reacts when there is no friction.
	 1 	 Open the “Quick Start.aep” project.
	 1 	Open the Options window by clicking the 3D Flag logo in the 
Effect Controls window.
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	 2 	Pause the animation by pressing the spacebar.
	 3 	Set Air Friction to 0. This allows the flag to fully respond to 
wind and gravity.

	 4 	Play the animation by clicking the Restart Simulation button.

 Notice that the flag flaps about quite a bit more than when Air 
Friction was 5. This is because there are less constraints on the 
flag’s movement.

Adding A Lot of Friction

Now let’s see what happens when we set the air friction to a high 
value.
	 1 	Pause the animation by pressing the spacebar.
	 2 	Change Air Friction to 50. This means that the flag will only 
respond to about 50% of what it’s requested to do. It would take a 
lot of wind to overcome that.
	 3 	Play the animation by clicking the Restart Simulation button. 
The flag now undulates slowly, as if it’s struggling just to move.
	 4 	When you’re done watching the flag, click the OK button to 
close the Options window.

Depending on the size of your mesh, a higher Air Friction can cre-
ate more folds in the flag as it undulates.

Usually, Air Friction values in the range of 0 to75 are sufficient.

Now that you’ve learned about the different parameters that af-
fect a flag’s look, How To Make Flags Look Large will show you 
how to use the different parameters to create flags that look big.

How To Make Flags Look Large

Overview

The default flag looks and acts like what we might consider a nor-
mal sized flag, one that is a few feet wide and a few feet tall.

With a few tweaks to the flag parameters, you can make your flag 
look large, ready to be attached to a flagpole dozens of feet high.

Lookin’ Large

The key to a flag looking large hinges on how it reacts to the 
environment:
	 • 	It cannot look too stiff.
 Large flags require a lot of material, and large sheets of material 
are loose.
	 • 	It cannot look too erratic.
 Large things take a long time to change, so a quickly flapping flag 
just won’t be convincing.
	 • 	It should have several folds in it.
 Large sheets of cloth fold easily.
	 • 	It should not be too upright.
 Big flags are heavy and easily pulled down by gravity.
	 • 	The wind should not blow through it too quickly.
 Even a good-paced wind will take longer to get through a large 
flag than a small flag.
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A Big Layer Equals A Big Flag, Right?

No, it doesn’t. There are many reasons not to use a big After Ef-
fects layer as your flag color layer, but the top two are:
	 1 	Memory usage.
 If you use a 4,000x3,000 layer as your color layer, the 3D Flag 
plug-in will create a flag image of that size. The memory required 
to hold an image that large in RAM is roughly 48 Megabytes! 
Compare that to a 640x480 image that only requires about 1.2 
Megabytes.
	 2 	It’s not the size, it’s the parameters.
 An enormous color layer would still generate a flag with the 
default Horizontal Mesh and Vertical Mesh values of 21x21. These 
two parameters are key when making a flag look large.

Changing The Environment

We’ll create a large-looking flag from our “Quick Start.aep” 
project. That flag is only 400x266, but we can modify just a few 
parameters and make it seem much larger.
	 1 	Open the “Quick Start.aep” project.
	 2 	In the Effect Controls window, turn down the Wind Speed 
parameter so that the flag moves more slowly. A value of 5 should 
work well. A slower moving flag simulates how wind will take 
longer to move across such a large flag.
	 3 	Find the Lock Points menu and select “Corners Only.” Large 
flags are usually not bound in the center. They are either tied 
along the entire edge, or just at the corners.

Changing Flag Attributes

Now that we’ve adjusted the wind speed and which points of the 
flag are locked, let’s adjust specific flag attributes to make are flag 
seem grand.
	 1 	Open the 3D Flag Options window by clicking on the 3D Flag 
logo in the Effect Controls window.

	 2 	Pause the animation by pressing the spacebar.
	 3 	We want our flag to have many folds in it as the wind blows 
through it, so we’ll increase our mesh density. Set Horizontal 
Mesh to 41. Set Vertical Mesh to 31. Setting these two values 
higher than the default of 21 will add complexity to the mesh, and 
that’s exactly what you’re looking for.

 Now that you have a large mesh, you need to adjust a few other 
parameters to make sure the flag acts large.
	 4 	A dense mesh may need some help in keeping its shape, so 
we’ll set Conform to a higher value, such as 10. Since the mesh is 
so large, it is more likely to look too springy, so a larger Conform 
value will help.
	 5 	Finally, we don’t want the flag to react too quickly to wind 
or gravity, so we’ll set Air Friction to 75. We want the flag to look 
really sluggish, as if it is so heavy, that it must struggle to stay 
upright.
	 6 	Play the animation by clicking the Restart Simulation button. 
The flag may not play back well in real-time on your computer 
since the mesh is so large. Notice the number of folds in the flag, 
and notice how gravity seems to be pulling the flag down.
	 7 	Click the OK button to close the 3D Flag Options window.

To view the full animation, either do a RAM Preview (Composi-
tion> Preview> RAM Preview) or render the scene out to a movie.



Zaxwerks - User Guide 38

Making A Flag Look Small

By using nearly the opposite technique described above, we can 
make a flag look small. The key is to minimize the mesh size (not 
the flag size).

Let’s make a flag that looks similar to the small, plastic flags that 
you may find at a car dealership or a grocery store.
	 1 	Open the “Quick Start.aep” project.
	 2 	Little flags are usually so stiff, that the entire side of the flag 
is mounted to a thin flagpole. In the Effect Controls window, find 
the Lock Points parameter and select “All Edge Points.”
	 1 	Open the Options window by clicking the 3D Flag logo in the 
Effect Controls window.

	 2 	Pause the animation by pressing the spacebar.
	 3 	We don’t want many folds in our mesh, so a small mesh den-
sity will work well. Set Horizontal Mesh to 5 and Vertical Mesh to 
2. These values will allow the flag to flap back and forth, but not 
up and down.
	 4 	To add a little more rigidity, set Air Friction to 10. This will 
help keep the flag under control, so that it doesn’t flap too quickly. 
We want it to look like it’s made of plastic, after all.
	 5 	Play the animation by clicking the Restart Simulation button. 
The flag moves back and forth, but can’t do much else since the 
mesh is so simple.
	 6 	When you’re done watching the flag, click the OK button to 
close the Options window.

This “little” flag acts very different than the “large” flag, even 
though they’re technically the same size in the scene. What differ-
entiates them is the complexity of the mesh that the flag is made 
from, along with a few other parameters. This is an important 
concept to remember when customizing your own flags.

Now that you’ve seen how to set up and modify your flags, we’ll 
teach you how to attach the flag’s locked points to another After 
Effects layer, allowing you to place your flags on pictures of flag-
poles and even move them around the scene. The next chapter is 
on Flagpoles.

Overview

Every flag needs a flag pole. Inside of After Effects there are 
two methods of creating flag poles. the Fast-&-Easy way and the 
Harder-but-more flexible way. This section will show you the Fast 
& Easy method. The harder method is explained in the next sec-
tion called Placing Your Flag In A 3D Scene.
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The Flagpole Menu

The Fast & Easy method uses the Flagpole menu. Find the Flag-
pole control and turn down the twirly arrow to reveal all of the 
Flagpole controls.

At first glance there are a LOT of controls. You need all of these 
controls to move and wave a flag in 3D space. However, you 
almost never use them all at once and if you take a look at them 
you’ll find they all make sense.

We said this was going to be fast and easy flagpoles didn’t we? 
OK, then let’s skip all of these controls for now, and get right to 
the good stuff.

Creating The Flagpole
	 1 	Find the Pole Image menu.
	 2 	Click on the menu and choose the “Vertical Pole - Medium 
- White” option.

 This will create a pole from the Flag Poles folder that comes with 
the program. If your Pole Image menu says there are no Flag Pole 
images, then you didn’t install the program correctly. Go back to 
the Installation Instructions and follow them exactly.

Auto-Positioning The Flag And Pole

At this point the Flagpole isn’t positioned at the side of the flag 
and there’s black around the edges. No problem...
	 1 	Find the Quick Start menu, which is located below the Pole 
Image menu.
	 2 	Drag to the “Large Flag” option and let up on your mouse 
button.

 This will cause the flag and flagpole to be auto-repositioned so 
they now look like a proper combination. You can do the same 
thing yourself by adjusting the Nudge and Position controls but 
this sure was a lot easier wasn’t it?

Removing The Black From The Flagpole Edges

To clean up the edges of the flagpole, render the animation at 
Best Quality, or set your layer or Monitor window to Best Quality.

What Else Can You Do With A Flagpole?
	 • 	You can use the Pole Position controls to move the flag to 
other positions on the screen.
	 • 	You can also use the Pole Rotation controls to wave the flag 
back and forth. Normally you think of a wave as a side to side 
thing (Z rotation). However a really cool look is to rotate the flag 
back and forth around the X axis. This is the in-out axis which 
gives you a cool 3D look.
	 • 	If the flag needs to rotate around a different point, use the 
Pole Pivot Offset to slide the pivot point along the length of the 
flag.
	 • 	If you need to adjust the position of the flag on the flagpole, 
use the pole Nudge controls.

If you need more control than the Flagpole parameters can pro-
vide, then you can always use the Attach To Layer option. This 
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technique lets you use any image in After Effects as a flagpole. It 
also lets you use the standard AE 3D controls to move the flag-
pole around. This is very useful when you need to combine a flag 
with other AE 3D layers. The next section , Placing A Flag In A 3D 
Scene, walks you through a project where you use the Attach To 
Layer features.

Attaching Your Flag To A Flagpole

Overview

So far, the flags you’ve created have remained in the center of the 
screen. In this section, you’ll attach a flag to a layer that looks like 
a flagpole. Flagpoles can be used to position your flag in a scene 
as well as move your flag around the scene.

The next few sections will use a lot of what you’ve learned so far.

Setting Up The Scene

Let’s say you have a picture of a house and you’d like to decorate 
it with a flag to celebrate a holiday. In this example, you’ll open 
a scene that has a 3D flagpole layer attached to a picture of a 
house. You’ll attach a flag to the flagpole and make the flag hang 
from the pole.
	 1 	Open the “House.aep” project.

 Your Comp window should look like this.

 This scene has a picture of a house as a background. There is a 
3D flagpole in the pole holder next to the window, as the red ar-
row shows.

 Let’s add a flag to this scene.
	 2 	As you may remember, we always add the 3D Flag effect to a 
layer that is the same size as the Comp, so let’s create a new Solid 
(Layer> New> Solid) for the flag effect. 

 Name the Solid “Holiday Flag.” Make sure the Solid is the same 
size as the Comp by clicking the “Make Comp Size” button. Make 
the Solid white.
	 3 	Click the OK button to create the Solid and add it to the proj-
ect. Your scene will now be covered by the new Solid.
	 4 	Add the 3D Flag effect to the new Solid by selecting Effect> 
Zaxwerks> 3D Flag.

 The Solid will turn into a flag. There is an image of an American 
flag in our project already. Let’s make the flag use that picture for 
its coloring and its size.
	 5 	In the Effect Controls window, find the Color From Layer 
parameter and select “USA.jpg.” Your flag will now look like an 
American flag.
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Attaching The Flag To The Pole

We’re now ready to start integrating the flag into the scene.
	 1 	In the Effect Controls window, open the Attach To Layer 
twirly.

	 2 	Find the Attach To Layer menu and select “Flagpole.tga.” 
This will put the flag in the same place as the flagpole. It is even 
rotated the same way as the flagpole.

 But it doesn’t quite look right, does it? The edge of the flag isn’t 
attached to the pole.

When a flag is attached to a flagpole, the center of the flag is 
placed at the center of the flagpole. In the next section,  Handling 
Alignment Issues With Offsets, you’ll learn how to use offsets to 
adjust the position of the flag on the flagpole.

You may wish to save this scene since we’ll be using it in the next 
section.

Handling Alignment Issues

Overview

In the previous section, you attached a flag to a flagpole, one that 
had been positioned and rotated to fit into a scene. You saw that 
the default attachment location wasn’t quite right.

In this section, you’ll learn how to align your flag with the layer 
you’re attaching it to.

This section uses the results of the previous section. If you don’t 
have that scene available, you may start with “House With Flag.
aep” in the “Flag Tutorials” folder.

By default, a flag attached to a 3D layer will be centered on that 
layer. Note that factors such as which edges are locked and which 
direction the wind is blowing will affect how this may look.

Offsetting The Flag

3D Flag has three controls that will allow you to offset the flag on 
the flagpole. You may move the flag in the X, Y, or Z direction.

NOTE: When offsetting a flag, X always means shifting the flag 
left or right along the flagpole, regardless of the orientation of the 
flagpole. Y always means up or down. Z always means in or out. 
The image below demonstrates this.
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Aligning The Flag To The Pole

Let’s offset the flag so that the locked points on the left edge line 
up with middle of the flagpole. We’ll do this by shifting the flag to 
the right.
	 1 	Select the “Holiday Flag” layer in the Timeline window.
	 2 	Open the Effect Controls window (Effect> Effect Controls).
	 3 	Find the Offset X parameter. Click on the default value of 0.0 
and drag to the right (that is, scrub the value to the right).

 Notice that as the Offset X value increases, the flag shifts to the 
right.
	 4 	Continue offsetting the flag to the right until the left edge of 
the flag lines up with the flagpole.

 Your Offset X value should be around 200, which is half the width 
of the flag image. This makes sense. To shift the left edge of the 
flag to the center of the flagpole, we moved it over by half its 
width.
	 5 	We’d like the flag to sit a little higher on the pole. Locate 
the Offset Y parameter and scrub that value, making the Offset Y 
value larger. Notice that increasing the Offset Y value moves the 
flag up the flagpole.

 Continue increasing the value until the top of the flag sits just 
below the top of the flagpole. A value of 20 should be about right.

 At this point, the flag is properly aligned to the pole.
	 6 	As a final step, we’ll remove the wind from the scene so that 
the flag hangs from the pole. Locate the Wind Speed parameter 
and set it to 0.

 Since we aligned the locked points on the flag to the flagpole, 
turning off the wind allowed the flag to hang while the locked 
points remained attached to the pole.

 Your scene is now complete.

You have just learned how to offset your flag so that the locked 
points of the flag are aligned with the flagpole. Once aligned, the 
locked points on the flag remained fixed to the flagpole, even 
when the wind speed changed. In the next section, In Sync: 
Animating The Flagpole, you’ll see that the locked points will stay 
with the flagpole even when the pole is animated.

In Sync: Animating The Flagpole

Overview

In this section, you’ll see how the locked points on a flag remain 
attached to an animated flagpole while the rest of the flag follows. 
You’ll also learn how to use the Click To Update Tracking button 
to keep your flag in sync with the flagpole animation.
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Setting Up The Scene

Let’s say you’re creating an animation of a flagpole that waves 
back and forth. You’ll need to animate the pole and then attach a 
flag to it. Follow the instructions below to get your scene ready.
	 1 	Open the “Animated Flagpole.aep” project. This scene has a 
flagpole that rotates back and forth.

 Let’s add a flag to the scene and attach it to the flagpole.
	 1 	Create a new Solid (Layer> New> Solid) for the flag effect. 
Name the Solid “Animated Flag.” Make sure the Solid is the same 
size as the Comp by clicking the “Make Comp Size” button. Make 
the Solid white.

 Click the OK button to create the Solid and add it to the project. 
Your scene will now be covered by the new Solid.
	 2 	Add the 3D Flag effect to the new Solid by selecting Effect> 
Zaxwerks> 3D Flag.

 The Solid will turn into a flag. There is an image of a British flag 
in our project already. Let’s make the flag use that picture for its 
coloring and its size.
	 3 	In the Effect Controls window, find the Color From Layer 
parameter and select “United Kingdom.jpg.” Your flag will now 
look like a British flag.

 Let’s attach the flag to the flagpole.
	 4 	In the Effect Controls window. locate the Attach To Layer 
parameter and select “Long Flagpole.tga.”

 The flag is now attached to the flagpole, but it needs to be 
aligned.

	 1 	In the Effect Controls window, find the Offset X parameter 
and increase the value until the left edge of the flag is aligned with 
the center of the pole. We want the locked points on the flag to 
line up with the pole. The value should be around 200.
	 2 	Now find the Offset Y parameter and increase the value until 
the flag sits just below the top of the pole. The value should be 
around 600.

Do a RAM Preview (Composition> Preview> RAM Preview) to 
see the flag animate with the pole. Majestic, isn’t it? Notice how 
the locked points stay attached to the animated pole while the 
rest of the flag follows.
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Adding Another Keyframe

This animation has three keyframes. The pole rotates left, then 
right. Let’s make it rotate to the left again, causing the pole to be 
straight up at the end of the animation.
	 1 	Select the “Long Flagpole.tga” layer in the Timeline window. 
This is the animated flagpole. It has Orientation keyframes at 
times 0 seconds, 2 seconds, and 4 seconds.
	 2 	Set the Time marker to time 5 seconds.
	 3 	Using the Rotation tool, rotate the flag to the left until it’s 
straight up. You should rotate the Z value back to 0 degrees. A 
keyframe will be automatically set since we changed the value of 
the Orientation.

 We’ve added a keyframe, but the flag has not kept up with the 
flagpole as we’ve rotated it.

 We need to tell the flag to update based on the new animation. 
It’s time to use the Click To Update Tracking button.

Updating Tracking

There is a mismatch between the location of the flagpole and the 
flag. Let’s correct this problem.
	 1 	Select the “Animated Flag” layer in the Timeline window.
	 2 	Open the Effect Controls window (Effect> Effect Controls) 
and find the Click To Update Tracking button. Click the Click To 
Update Tracking button.

 The flag will now snap into place, in its correct position and 
orientation.
	 3 	Play the new animation from the start by doing a RAM 
Preview (Composition> Preview> RAM Preview). Watch the flag 
rotate back and forth.

The Click To Update Tracking Button

The Click To Update Tracking button is used to synchronize a flag 
to its flagpole.

When animating a flagpole, the 3D Flag plug-in isn’t always noti-
fied when the flagpole has moved. Clicking the Click To Update 
Tracking button will tell the flag to get into its proper position.

If you see that your flag is not in sync with your flagpole, click the 
Click To Update Tracking button.

As you’ve been working with 3D Flag, you may have noticed that 
the flag can sometimes intersect itself, creating a flag that doesn’t 
look very real. The next chapter, Self-Collision - Adding Realism 
will discuss a way to make your flag scenes more realistic.

Overview

Without any special constraints, a flag is free to intersect itself as 
it flaps around. This section will demonstrate how you can use 
the Prevent Self-Intersection parameter to add realism to your 
flag’s animation.
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A Demonstration Of Self-Intersection

Let’s say you have a flag flapping in the wind, and the wind dies 
down, but then it picks up again. The flag will droop as the wind 
subsides, but it will begin undulating again once the wind speed 
increases. We’ll see that such a scenario can cause self-intersec-
tion.
	 1 	Open the “Intersection.aep” project. This scene has a Swed-
ish flag with an animated Wind Speed parameter. The wind dies 
down and then picks up. As this happens, we’ll see that the flag 
intersects itself.

	 2 	Set the time marker to time 0:20 (the 20th frame, less than 1 
second).

 Notice the self-intersection. As the wind dies down, the flag 
droops, causing the flag to overlap itself.
	 3 	To see the animation in action, open the Options window by 
clicking the 3D Flag logo in the Effect Controls window.

Watch the animation play. Press the Restart Simulation button to 
start the animation over. You can see several frames where the 
flag intersects itself.
	 4 	Once you’ve finished viewing the animation, press the OK 
button to close the Options window.

Removing Self-Intersection

To fix the self-intersection problem, we’ll use the Prevent Self-In-
tersection parameter.
	 1 	Select the “Intersection Flag” layer in the Timeline window.
	 2 	Open the Effect Controls window (Effect> Effect Controls) 
for that layer.
	 3 	Find the Prevent Self-Intersection parameter at the bottom 
of the Effect Controls window and select “On.”

 The scene will recalculate, and then the Comp window will show 
that the flag no longer intersects itself.

	 4 	Open the Options window to view the new animation.

NOTE: Since Prevent Self-Intersection is on, the Options window 
will display the animation in Frame-By-Frame mode. It will also 
play slower than normal, since it requires extra CPU power to do 
the self-intersection calculations.

 When you’re done viewing the animation, press the OK button to 
close the Options window.
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The Prevent Self-Intersection parameter can be used to fix situ-
ations where a flag intersects itself. While using the parameter 
can solve many of your self-intersecting problems, it may not fix 
every situation, as you’ll see in the next section, Advantages And 
Limitations.

Advantages And Limitations

Overview

While the Prevent Self-Intersections parameter can be used 
in many situations to prevent a flag from penetrating its own 
surface, it has its limitations. This section discusses when this 
parameter works best. It also describes this parameter’s short-
comings.

How Prevention Works

At each frame, the “Prevention Algorithm” puts a force field 
around the points in the flag. If a flag point tries to enter the force 
field, it is pushed away.

NOTE: The Prevention Algorithm does not occur during the Pre-
Roll process. Therefore, if a flag is self-intersecting at the first 
frame after pre-rolling, the Prevention Algorithm may not be able 
to undo the intersection for that frame. It may also have trouble 
clearing up the intersections in subsequent frames.

Advantages

There are several scenarios where the Prevent Self-Intersections 
parameter works well. These mostly involve times when the flag 
briefly overlaps itself in an animation. Turning on this parameter 
can usually get rid of the self-intersection without greatly chang-
ing the animation itself.

The Prevention Algorithm has many advantages.
	 • 	It’s fast.
	 • 	It doesn’t change the animation of the flag unless it needs to.
	 • 	It can clean up self-intersections in one area of a flag without 
modifying the other areas of a flag.
	 • 	It can prevent multiple intersections at once.

In many situations, you won’t have to use the Prevent Self-Inter-
sections parameter. A properly undulating flag usually will not 
intersect itself. But for those times when your animation just 
won’t look right because a flag is intersecting itself, the Prevent 
Self-Intersections parameter can be used to make your animation 
look more realistic.

Limitations

While the Prevent Self-Intersections parameter can be used to 
great effect in many situations, there are scenarios that it may not 
handle well, such as:
	 • 	Rapidly-moving flags. If the movement between each frame 
is too great, intersections may still occur.
	 • 	Overly-bunched flags. If your flag folds over itself too many 
times, there may not be a good way to unfurl it.
	 • 	Once self-intersection does occur, it may stay that way. The 
Prevention Algorithm cannot usually fix a self-intersection once it 
happens.
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An Ounce Of Prevention Is Worth A Pound Of Cure

The best way for you to avoid creating a flag with self-intersec-
tions is to use parameters that won’t cause self-intersection in the 
first place.

If you’ve tried the Prevent Self-Intersections parameter and it 
hasn’t worked for you situation, you may want to try one of the 
following solutions. Each of the items below can be used to help 
you not have self-intersections in the first place.
	 • 	Change the wind speed. A slightly slower or faster wind will 
change the way a flag flaps.
	 • 	Animate the wind speed. This is especially useful if the flag 
only self-intersects at a few points in time. By setting a few wind 
speed keyframes around the time of self-intersection, you may be 
able to get rid of the intersections without changing the overall 
wind speed for the animation.
	 • 	Avoid overly-rubbery flags. Loose flags tend to flap about 
quite a bit. If you can minimize how high the Flag Stretch, Flag 
Bend, and Flag Shear values are, you may be able to keep your 
flag flapping in the wind, and not into itself. A higher Conform 
value may help as well.
	 • 	Keep the mesh size down. Find the minimum Horizontal 
Mesh and Vertical Mesh values that will suit your needs. An 
overly-complex mesh will create more folds, and therefore more 
chances of self-intersection.

The next chapter, Working With Multiple Flags, will discuss ways 
to make your flags unique. It will also demonstrate how to quickly 
reuse the animation from one flag to create many animations with 
different flag images.

Working With Multiple Flags

As you get more advanced with your flag work you
 may want to create scenes that include multiple
flags. This chapter discusses techniques you can use to
make each flag look unique, and describes ways to
reuse an animation for different flags.

	 • 	Why Do My Flags Look Identical? 
	 • 	Reusing Animation For Different Flags

Why Do My Flags Look Identical?

Overview

In this section, you’ll create a scene with two flags. At first, 
they will look identical, but we’ll show you how to make subtle 
changes so each flag looks unique.
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Creating A Scene With Two Flags

This section will show you how to create a scene with two flags, 
both on the same flagpole.
	 1 	Open the project called “Flagpole Single.aep” found in the 
“Flag Tutorials” folder. This project was created using techniques 
discussed in Attaching Your Flag To A Flagpole. The Comp win-
dow should look like this image.

 In this picture, the flagpole was part of the background image. 
This flag is attached to a flagpole layer, but that layer is hidden.
	 2 	Turn on the visibility of the “Flagpole” Solid layer.

 Now you can see the long, skinny Solid that the flag is attached 
to. Notice how the “Flagpole” Solid layer has been placed in the 
scene to cover up the flagpole in the background picture. We use 
this fake flagpole as our guide, and then turn off its visibility once 
everything has been oriented properly.
	 3 	Turn off the visibility of the “Flagpole” Solid layer.

Adding A Second Flag To The Flagpole

	 1 	Duplicate the “Top Flag” layer by selecting the “Top Flag” 
layer in the Timeline window and then selecting Edit> Duplicate.
	 2 	Rename the new layer “Bottom Flag.”
 This layer is an exact duplicate of the “Top Flag” layer. This 
means that the flags are in the same place and are attached to the 
same flagpole. Let’s make the second flag lower on the pole than 
the first flag.
	 3 	Open the Effect Controls window (Effect> Effect Controls).
	 4 	Lower the Offset Y value until one flag is below the other. A 
value of 225.0 should do the trick.
	 5 	In the Effect Controls window, select “Red Crescent.jpg” 
from the Color From Layer menu. You now have two flags on the 
same pole.

	 6 	View the first few seconds of the animation by doing a RAM 
Preview (Composition> Preview> RAM Preview).
	 7 	Notice how the flags move in exactly the same way. Let’s fix 
this.

Making Flags Unique

While you can probably imagine that changing just about any 
parameter on one of the flags will make the two flags look dif-
ferent, you’ll still want them to look like they’re part of the same 
scene. That is, you’ll want them to look like they’re receiving the 
same wind and other forces. You may also want them to look like 
they’re made out of the same material. Choosing the right param-
eters to change is important.

Let’s make the “Red Crescent.jpg” flag similar but different.
	 1 	Select the “Bottom Flag” layer.
	 2 	Open the Effect Controls window (Effect> Effect Controls). 
Since these two flags are so close to each other, we can’t change 
the wind direction, but we can change the wind speed by a small 
amount. This won’t change the overall look, but will help break 
up the synchronization of the two flags.
	 3 	Set Wind Speed to 10.5.
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	 4 	View the first few seconds of the animation by doing a RAM 
Preview (Composition> Preview> RAM Preview). The flags aren’t 
as synchronized as they were before, but they still look too much 
alike. By changing the Pre-Roll value, we can offset how far along 
in the animation we are. This will add some uniqueness to the 
“Bottom Flag.”
	 5 	Set the Pre-Roll value to 3.0. This will differentiate how 
many frames are calculated for each flag. This will make the flags 
look different for a few seconds, but it may not help over longer 
periods of time, when the flags get into their patterned undula-
tion.
	 6 	View the first few seconds of the animation by doing a RAM 
Preview (Composition> Preview> RAM Preview). Notice how the 
flags seem to act independent of one another.

You could probably stop here and have perfectly acceptable 
results, but let’s go a bit further and look at some other ways to 
make flags different.

Making Flags Even More Unique
	 1 	Open the Options window by clicking on the 3D Flag logo at 
the top of the Effect Controls window.
	 2 	Press the spacebar to pause the animation. Let’s make the 
flag look like it’s made of a slightly different material.
	 3 	Set Flag Stretch, Flag Bend, and Flag Shear each to 5.0.

	 4 	This makes the flag a little more loose and stretchy. More im-
portantly, it will react to the wind differently than the “Top Flag.”

 Click the OK button to close the Options window.

	 5 	View the first few seconds of the animation by doing a RAM 
Preview (Composition> Preview> RAM Preview). The flags look 
like they’re reacting to the same wind, but they are flapping in 
their own unique way.

Deciding Which Parameters To Change

The chart below describes how the different parameters can be 
used to achieve different looks.

In the next section, Reusing Animation For Different Flags, you’ll 
learn how changing a single 3D Flag parameter can facilitate the 
creation of five animations.

Reusing Animation For Different Flags

Overview

Since 3D Flag allows you to change the layer that the flag color 
comes from, you can quickly create multiple versions of the same 
animation.

Let’s say you get a job where you need to create five flag anima-
tions, each using the flag of a different country. It’s OK for each 
animation to be the same but the flag in each one needs to be 
different.

ECW Parameter
How It Can Make 
Flags Different

Wind Speed

Wind Direction

Small differences can help 
the flags undulate at different 
rates.

Larger differences can make 
flags look like they’re in differ-
ent parts of the scene (that is, 
far away from each other).

Flags can look like they’re in 
different parts of a scene.

Pre-Roll By having different Pre-Roll 
values, flag undulations will 
occur at different times.

Options Window 
Parameter

How It Makes Flags 
Different

Flag Stretch/
Bend/Shear

Conform Changes the material of the flag.

Horizontal/
Vertical Mesh

Changes the material of the flag.

Changes the material of the flag.
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Creating The First Animation

The first step is to get together the pieces we will be using and 
taking a look at those pieces.

We’ll use the flag we started with in the previous section to get us 
going.
	 1 	Open the “Multiple Flags.aep” project which is located inside 
the “Flag Tutorials” folder.

When the project opens it should look like this image.

 This project is very similar to the one we used in the last tutorial. 
The main difference is that it contains five flags all sitting in the 
Timeline ready to go. Notice that their visibility has been turned 
off. We don’t need to see them in the Comp window. They just 
need to be in the Timeline so that we can use them to color the 
flags.

 Since we’ll be reusing this animation for five different flags, we’ll 
want to make sure that the flag size does not change when we re-
place one flag with another. Some of the original flag pictures may 
be larger than others, but we want all flags to be the same size in 
the final animation.
	 2 	Select the “Flag Solid” layer.
	 3 	Open the Effect Controls window (Effect> Effect Controls).
	 4 	Find the Size From control and choose the “Width and 
Height” option.

 This will fix the size of the flag to 400 by 210 which is the size 
of the US flag. Once you fix the size of the flag, using the “Width 
and Height” option, you can substitute other images and the size 
of the flag will not change. If the size of the flag changes it takes 
extra time adjusting the alignment of the flag to the flagpole, so 
learning how to fix the size of the flag is very useful.

Creating Five Identical Animations

Now that our scene is ready, we’ll render five animations in a row. 
We’ll only make a single change to the Flag Solid between each 
render. Since we’re only making a single change each time, there 
is no need to duplicate the Comp and render out five composi-
tions, although if you’d like to render all five at once you could do 
it that way.

We’re going to assume that you already know how to use the 
Make Movie command, and how to set your render settings, so 
the procedure goes like this:
	 1 	Use the Make Movie command.
	 2 	Set the render settings. Remember that you need the Best 
quality settings in order to get antialiasing and non-rectangular 
shapes, if you’re using these features.
	 3 	Render the movie.
	 4 	After the movie is done rendering, select the “Flag Solid” 
layer in the Timeline window.
	 5 	Open the Effect Controls window (Effect> Effect Controls).
	 6 	Find the Color From Layer menu and choose the “Australia.
jpg” flag. The flag in the Comp window will change into an Austra-
lian flag.
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Repeat the sequence of steps for each flag. When you are done 
you will have five identical animations with a different flag in 
each.

In the next chapter, Other Creative Uses For Flags, you’ll discover 
that 3D Flag can be used to create more than just flags.

Creating A Balloon String With A Thin Flag

Overview

At its core, 3D Flag simulates springs pushing and pulling points 
in space. When you lay out a grid of these springy points, you get 
cloth. String can be simulated with springs as well. This section 
demonstrates how you can create something that looks and acts 
like string with a very thin flag.

Setting Up The Scene

	 1 	Open the “Balloon.aep” project in the “Flag Tutorials” folder.

When the project opens it should look like this.

The project consists of a sky background, an animated balloon, 
and a layer that we’ll use to specify the string color and size. 
There is also a layer (hidden for now) that we’ll use as our flag 
layer. Our goal is to turn the string into a thin flag, and then attach 
it to the balloon.

Creating The String

We have our string in the scene already. It’s a thin Solid. We want 
to use it to create a flag.
	 1 	Turn off the visibility of the “String Solid” layer. Turn on the 
visibility of the “Flag Solid” layer. Then, apply the 3D Flag effect 
to the “Flag Solid” layer. The white layer will turn into a flag.
	 2 	In the Effect Controls window, find the Color From Layer 
menu and select “String Solid.” The big white flag turns into a thin 
white flag. We now want to make this thin flag look and act like a 
string.
	 3 	Locate the Lock Edges menu and elect “Top.” Then find 
the Lock Points menu and select “All Edge Points.” You’ll see 
the white flag start to look like a long string in the middle of the 
screen.
	 4 	Let’s turn the wind into to a very slight breeze. Set Wind 
Speed to 1.

Attaching The String To The Balloon

We want the string to be attached to the bottom of the balloon 
and sway in the wind as the balloon animates across the screen.
	 1 	In the Attach To Layer menu, select “Balloon.tga.”. The string 
will now travel with the balloon. To make the top of the string 
line up with the bottom of the balloon, we’ll use the Offset X and 
Offset Y parameters.
	 2 	Use the Offset X and Offset Y controls to move the string so 
that the top of the string hangs from the bottom of the balloon. 
An Offset X value of -3 and an Offset Y value of -278 should be 
about right.
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The string now follows the balloon as it floats across the screen. 
The bottom portion of the string sways with the movement of the 
balloon. Pretty cool, huh?

Making balloon strings is just the start. In the next section, Transi-
tioning Between Two Layers, you’ll see how you can take advan-
tage of wind and gravity to transition from one layer to another.

Transitioning Between Two Layers

Overview

This section shows how to create an organic transition between 
two layers. You’ll remove the edge constraints from the flag and 
let wind and gravity push it across the screen, revealing the layer 
behind the flag.

Setting Up The Scene

For this example, let’s say you’re creating a slide show of your 
trip to Greece and you want to use 3D Flag to transition between 
two pictures.
	 1 	Open the “Transition.aep” project in the “Flag Tutorials” 
folder.

 When the project opens it should look like this.

	 2 	Select the “Greece1.jpg” layer and add the 3D Flag effect to 
it (Effect> Zaxwerks> 3D Flag). The layer will become a flag and 
the Effect Controls window will be displayed.

 Since “Greece1.jpg” is the same size as our Comp, and since the 
contents of the layer is what we want on the flag, we can apply 
the 3D Flag effect directly to it. This saves us an extra step of hav-
ing to create an additional Solid that we would apply the effect to.
	 3 	In the Effect Controls window, set Pre-Roll to 0. This will put 
the flag in its default position, flat against the screen. Since the 
flag layer is the same size as the Comp, it completely covers the 
layer behind it. In fact, we can’t even tell it’s a flag.
	 4 	Find the Lock Edges menu and select “None.” Then locate 
the Lock Points menu and select “None.” You just freed the flag so 
that it can be blown across the screen.

Creating A Transition

By doing the steps above, you’ve created a flag that will fall off 
the screen, revealing the “Flagpole Double” layer behind it. Let’s 
turn the “fall” into a “peel” to make the effect more interesting as 
a transition.
	 1 	Preview the animation by opening the Options window. 
Notice that the flag just falls towards the ground. With no locked 
points, the flag is free to react to wind and gravity without con-
straints. For our purposes, the flag falls too fast, and there isn’t 
enough time for the wind to affect the flag. Click the OK button to 
close the Options window.
	 2 	Set Wind Dir Angle to 95. This will cause the flag to be blown 
slightly towards the camera, instead of away from the camera. 
This will make the flag peel towards the camera.
	 3 	Set Gravity to 1.0. This will allow the flag to fall just a little 
bit before being blown to the side.
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 Preview the final animation to see the transition (Composition> 
Preview> RAM Preview).

By utilizing the cloth-like nature of flags, and by not locking down 
any of the points on the flag, you can create unique transitions 
between layers.

In the next section, Animating Text, you’ll see how flags can bring 
your text to life.

Animating Text

Overview

This section will show you how 3D Flag can be used to create 
animated text, which can add a dynamic element to your scene.

Let’s say you are creating titles for a weather station, and want to 
make your text move like it’s being blown by the wind to indicate 
a storm brewing.

Setting Up The Scene

	 1 	Open the “Weather.aep” project in the “Flag Tutorials” folder.

When the project opens it should look like this.

The scene consists of some text over a background. We want to 
make the text undulate as if it’s mimicking the stormy conditions.
	 2 	Select the “Weather Text.tga” layer and add the 3D Flag ef-
fect to it (Effect> Zaxwerks> 3D Flag). The layer will become a 
flag and the Effect Controls window will be displayed.

 Since “Weather Text.tga” is the same size as our Comp, and since 
the contents of the layer is what we want on the flag, we can 
apply the 3D Flag effect directly to it. This saves us an extra step 
of having to create an additional Solid that we would apply the 
effect to.

 Note that since “Weather Text.tga” has an alpha channel (that 
is, it has transparent areas), we have set the Quality setting for 
this layer to Best. This tells the 3D Flag plug-in that the flag won’t 
have a rectangular shape.
	 3 	In the Effect Controls window, find the Lock Edges menu 
and select “All Sides.” The locate the Lock Points menu and select 
“Corners & Two Centers.” This will bind the flag at several points 
around the edges, but still allow some looseness.
	 4 	Open the Options window by clicking on the 3D Flag logo 
in the Effect Controls window. The wind moves the text, but not 
very much. We’d like to make the text undulate more.
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Making The Text Undulate More

The key to making the text undulate more is to increase the mesh 
density. This will allow more folds in the flag as the wind blows 
through it.
	 1 	With the Options window still open, pause the animation by 
pressing the spacebar.
	 2 	Click the wireframe ball above the Preview window to view 
the flag in Wireframe mode.

 The edges are bound at the corners and at two places along each 
edge.
Since the flag is bound on all sides, there’s no chance of it flap-
ping too wildly.
	 3 	Set both the Horizontal Mesh and Vertical Mesh to 41. This 
gives the flag more complexity, thereby allowing it to be affected 
more by the wind.
	 4 	Click OK. This will accept the changes and close the Options 
window.

	 5 	Do a RAM Preview (Composition> Preview> RAM Preview). 
The text now undulates on the screen.

Now that you’ve seen how binding the edges of the flag can help 
create dynamic text, the next section, Generating Dramatic Back-
ground Elements, will show you how a similar technique can be 
used to create flowing backgrounds.

Generating Dramatic Background Elements

Overview

By locking down all points along the edge of a flag, you can make 
the flag completely cover the Comp window. The interior of the 
flag will still react to wind and gravity, giving you the opportunity 
to generate dramatic background elements.

Let’s say you are creating the titles for an awards show and you 
want to generate a background that looks like a flowing drape or 
curtain. We’ll use a similar technique as we did in the previous 
section, only we’ll apply it to the background image.

Setting Up The Scene
	 1 	Open the “Awards Show.aep” project in the “Flag Tutorials” 
folder.

 When the project opens it should look like this image.

The red background is pretty boring. Let’s make it more dramatic 
by turning it into cloth.
	 2 	Select the “Red Background” layer and add the 3D Flag 
effect to it (Effect> Zaxwerks> 3D Flag). The background will 
become a flag and the Effect Controls window will be displayed.
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Since the “Red Background” layer is already the color and size 
that we want for our background, we don’t have to select any-
thing special in the Color From Layer menu. Note that this tech-
nique only works if the background layer is the same size as the 
Comp.
	 3 	In the Effect Controls window, locate the Lock Edges menu 
and select “All Sides.” Then find the Lock Points menu and select 
“All Edge Points.”

The flag edges are now locked to the edges of the Comp win-
dow because the “Red Background” layer is the same size as the 
Comp.
	 4 	Open the Options window by clicking on the 3D Flag logo at 
the top of the Effect Controls window. It looks ok, but let’s see if 
we can make it look even more dramatic.

Adding Drama

One way to make the scene more dramatic is to make the flag 
look large and silky, so the wind creates grand billows across the 
surface.
	 1 	With the Options window still open, pause the animation by 
pressing the spacebar.
	 2 	Set Flag Stretch, Flag Bend, and Flag Shear each to 5. This 
will make the flag loose.
	 3 	Set Horizontal Mesh and Vertical Mesh each to 41. This will 
allow the wind to create more folds in the flag, making it seem 
large. The folds will also cause the flag to catch the light better.
	 4 	View the animation by pressing the Restart Simulation but-
ton. Undulations now sweep across the flag.
	 5 	Click OK to accept the new values and close the Options 
window.

 The scene is now much more dramatic than it was before. The 
addition of a realistic, flowing cloth background has added a lot 
of production value to this graphic.

Between balloon string, text, and background elements, you’ve 
had pretty good exposure to how the clothy nature of flags can be 
used for other purposes.

At this point, you should feel comfortable putting flags in your 
scene and animating them. You should also be ready to find alter-
native, creative uses for flags.

You may wish to review certain chapters, or you may continue on 
to the References section, where you can find more details about 
specific parameters.

The first reference is the Effect Controls Reference.
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Effect Controls Reference

Click on one of the parameters or buttons in the picture below for 
more information on that item.

Parameters And Buttons

Reset

Press this button to change all of the ECW parameters back to 
their default values.

Options

Press this button to open the 3D Flag Options window. In the 
Options window, you can view the flag animation in real-time and 
change flag parameters.

You can learn more about using the Options window in Changing 
Flag Attributes.

About

Press this button to show the 3D Flag About box, which provides 
information about the 3D Flag plug-in.

Color From Layer

This parameter shows a list of every layer in your Comp.

When you choose a layer, the flag will use the contents of that 
layer to color the flag.

You can learn more about this parameter in Coloring The Flag.

Size From

This parameter determines how the flag width and height are 
determined.

You have the following choices:
	 • 	Color Layer - The size of the flag will be based on the size of 
the layer chosen in the Color From Layer parameter.
	 • 	Width and Height - The size of the flag will be based on the 
values of the Width and Height parameters.

You can learn more about this parameter in Automatically Resiz-
ing A Flag and Manually Resizing A Flag.

Width

If Size From is “Width and Height,” the flag will have this width, in 
pixels.

You can learn more about this parameter in Manually Resizing A 
Flag.
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Height

If Size From is “Width and Height,” the flag will have this height, 
in pixels.

You can learn more about this parameter in Manually Resizing A 
Flag.

Lock Edges

This parameter determines which edges of the flag have locked 
points. The Lock Points parameter determines which points along 
the chosen edges are locked.

You have the following choices:
	 • 	None
	 • 	Left
	 • 	Right
	 • 	Top
	 • 	Bottom
	 • 	Left & Right
	 • 	Top & Bottom
	 • 	All Sides

You can learn more about this parameter in Locking Points - Ma 
king A Hanging Banner and the chapter Other Creative Uses For 
Flags.

Lock Points

This parameter determines which points along the edges speci-
fied by Lock Edges are locked.

You have the following choices:
	 • 	None
	 • 	All Edge Points
	 • 	Corners Only
	 • 	Corners & One Center
	 • 	Corners & Two Centers

You can learn more about this parameter in Locking Points - Ma 
king A Hanging Banner and the chapter Other Creative Uses For 
Flags.

Click To Update Tracking

When the flag is attached to a 3D layer, and you are animating the 
3D layer by setting keyframes, the flag may not follow properly.

You can click this button to force the flag into its proper position 
if the flag and the attached layer are out of sync.

You can learn more about this parameter in In Sync: Animating 
The Flagpole.
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Attach To Layer

This parameter shows a list of every layer in your Comp.

You can attach a flag’s locked points to a 3D layer by choosing 
an item in this menu. Where the attachment layer goes, the flag’s 
locked points go. The rest of the flag will follow.

You can learn more about this parameter in How To Place Your 
Flag In A 3D Scene.

Offset X

Initially, the center of the flag is attached to the center of the At-
tach To Layer parameter.

You can set this parameter to shift the flag left and right on the 
attachment layer.

This value is in pixels.

You can learn more about this parameter in Handling Alignment 
Issues With Offsets.

Offset Y

Initially, the center of the flag is attached to the center of the At-
tach To Layer parameter.

You can set this parameter to shift the flag up and down on the 
attachment layer.

This value is in pixels.

You can learn more about this parameter in Handling Alignment 
Issues With Offsets.

Offset Z

Initially, the center of the flag is attached to the center of the At-
tach To Layer parameter.

You can set this parameter to shift the flag towards or away from 
the attachment layer.

This value is in pixels.

You can learn more about this parameter in Handling Alignment 
Issues With Offsets.

Speed Presets

By default, wind blows at a constant rate. You can choose an 
option from this menu to automatically create a set of keyframes 
that animate the Wind Speed parameter. Each options has a base 
wind speed value and different periods of constant wind, increas-
ing wind speed, and decreasing wind speed.
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When choosing one of these options, any existing Wind Speed 
keyframes will be cleared and new ones will be created. Random 
numbers are used to determine where the keyframes are created.
Your choices are:
	 • 	Lazy - Variable
	 • 	Lazy - Steady
	 • 	Breezy - Variable
	 • 	Breezy - Steady
	 • 	Windy - Variable
	 • 	Windy - Steady
	 • 	Gusty - Variable
	 • 	Gust - Steady
	 • 	Clear Keyframes - This option will clear any existing Wind 
Speed keyframes and reset the Wind Speed to 11.0.

You can learn more about this parameter in Using Wind Presets 
To Create Gusts.

Wind Speed

This parameter determines how strongly the wind blows. The 
direction of the wind is determined by Wind Dir Angle and Wind 
Dir Elevation.

You can learn more about this parameter in The Need For (Wind) 

Speed.

Direction Presets

By default, wind blows to the right (actually, slightly off right).

You may choose an option from this menu to change the Wind Dir 
Angle and Wind Dir Elevation values.

Your choices are:
	 • 	Left
	 • 	Right
	 • 	Forward
	 • 	Back
	 • 	Up
	 • 	Down

You can learn more about this parameter in Changing The Wind 
Direction.

Wind Dir Angle

This angle, in degrees around the global Y axis, is the direction 
that the wind is blowing.

In respect to a default camera in a scene, then:
	 • 	0 degrees is away from the camera (down the global positive 
Z axis).
	 • 	90 degrees is to the right (down the global positive X axis).
	 • 	180 degrees is towards the camera (down the global negative 
Z axis).
	 • 	270 degrees is to the left (down the global negative X axis).

You can learn more about this parameter in How To Animate 
Wind Direction.
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Wind Dir Elevation

This angle, in degrees, represents how high or how low the wind 
is blowing.
	 • 	90 degrees is completely vertical (up).
	 • 	0 degrees has no elevation.
	 • 	-90 degrees is completely vertical (down).

You can learn more about this parameter in How To Animate 
Wind Direction.

Gravity

This parameter determines how quickly points on the flag will be 
pulled down due to an accelerated gravitational force.

You can learn more about this parameter in Earth Or Moon: Grav-
ity And Slow Motion.

Pre-Roll

This parameter, in seconds, determines how many animation 
frames are calculated before the first frame of the flag is available 
for display.

At 0.0 seconds, the flag is in its default position.

Self-Intersection prevention does not occur during the pre-roll 
period.

You can learn more about this parameter in Using Pre-Roll To 
Find The Perfect Wave.

Prevent Self-Intersection

When set to “Off,” your flags may intersect themselves.

When set to “On,” 3D Flag tries to prevent the flag from intersect-
ing itself at each frame.

Self-Intersection prevention does not occur during the pre-roll 
period.

You can learn more about this parameter in Preventing Self-Inter-
section.

3D Flag Options Window Reference

Click on one of the parameters or buttons in the picture below for 
more information on that item.

Parameters And Buttons

Preview Window

This window displays the flag animation using OpenGL. The 
smoothness of the animation playback depends on your CPU and 
your graphics card.
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You may change your view of the flag by clicking and dragging 
inside the window.

You may use keyboard commands to control the animation play-
back.

You can find more information about this window in the chapter 

Changing Flag Attributes.

Playback Mode

You may choose to play the animation in real-time or a frame at a 
time.

The two options are:
	 • 	Real-Time - play the animation in real-time, dropping frames 
as necessary
	 • 	Frame-By-Frame - play every frame of the animation, no mat-
ter how long it takes to calculate each frame.

You can learn more about playback modes in Controlling Anima-
tion Playback.

Time

This text field displays the current time in the animation. It dis-
plays the time as a timecode as well as a number of seconds.

The time does not include pre-roll time. That is, a timecode of 
“0:00” means the first frame after pre-roll.

You can learn more about using the Time field in Using Pre-Roll 
To Find The Perfect Wave.

FPS

This text field displays the current animation playback framerate, 
in frames per second.

Wind Speed

This field displays the current wind speed being applied to the 
flag in the Preview window.

If the Wind Speed parameter in the Effect Controls window is 
animated, the animated effect will be shown here.

Wireframe Display Mode

Press this button to show the flag in the Preview window using a 
wireframe display.

You can learn more about this button in Changing Your View Of 
The Flag.

Shaded Display Mode

Press this button to display a white, non-textured flag in the Pre-
view window.

You can learn more about this button in Changing Your View Of 
The Flag.



Zaxwerks - User Guide 62

Textured Display Mode

Press this button to show a textured flag in the Preview window.

The texture used for the flag is the contents of the Color From 
Layer parameter in the Effect Controls window at the current 
frame when the Options window is opened.

You can learn more about this button in Changing Your View Of 
The Flag.

You can learn more about the Color From Layer parameter in 
Coloring The Flag.

Flag Presets

You may either set the flag parameters individually, or you may 
select a Flag Preset, which will set the parameters for you.

The options for this menu are:
	 • 	Stiff Flag (the default flag)
	 • 	Loose Flag
	 • 	Limp Flag
	 • 	Rubbery Flag

The parameters that are affected by presets are:
	 • 	Flag Weight
	 • 	Flag Stretch
	 • 	Flag Bend
	 • 	Flag Shear
	 • 	Conform
	 • 	Air Friction

You can learn more about Flag Presets in Making a Rubbery Flag 
With Presets.

Flag Weight

This parameter determines the weight of each point in the flag 
mesh.

Flags with a large weight won’t react to wind as strongly as points 
with a small weight.

You can find more information about this parameter in Changing 
A Flag’s Weight.

Flag Stretch

This parameter specifies the percentage of length a Stretch spring 
may expand or compress during the calculation of an animation 
frame.

You can learn more about this parameter in Understanding 
Stretch, Bend, And Shear.
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Flag Bend

This parameter specifies the percentage of length a Bend spring 
may expand or compress during the calculation of an animation 
frame.

You can learn more about this parameter in Understanding 
Stretch, Bend, And Shear.

Flag Shear

This parameter specifies the percentage of length a Shear spring 
may expand or compress during the calculation of an animation 
frame.

You can learn more about this parameter in Understanding 
Stretch, Bend, And Shear.

Conform

This parameter specifies the number of iterations that are done 
during the spring calculations in the flag simulator.

The overall result of making this parameter having a higher value 
is that the flag will conform to its desired shape better.

You can learn more about this parameter in Getting The Wrinkles 
Out With Conform.

Air Friction

This parameter specifies, as a percentage, how much the anima-
tion of a flag slows down during each frame calculation.

A larger value will make the flag look more sluggish, or it may 
make the flag look like it’s moving in slow motion.

You can learn more about this parameter in Using Air Friction To 
Slow Things Down.

Meshing Style

Flags are constructed from a grid of triangles. The triangles may 
be built with the diagonal to the right or to the left.

Your rendered flag may look smoother when choosing one mesh-
ing style over the other.

You can learn more about this parameter in Choosing Between 
Right And Left Meshing.

Horizontal Mesh

Flags are, at their core, a rectangular mesh of points. This param-
eter specifies how many points are in each row.

Larger values will make more complicated flags that can create 
more folds.

You can learn more about this parameter in How To Determine 
The Best Mesh Size.
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Vertical Mesh

Flags are, at their core, a rectangular mesh of points. This param-
eter specifies how many points are in each column.

Larger values will make more complicated flags that can create 
more folds.

You can learn more about this parameter in How To Determine 
The Best Mesh Size.

Motion Blur Steps

When a Comp is rendered with motion blur (and the layer that 
has 3D Flag applied to it has motion blur enabled), this parameter 
specifies the number of sub-frames that are rendered for each 
frame.

Higher values will produce a better blurred result, but will also 
take longer to render.

Restart Simulation

Press this button to restart the animation at timecode 0:00.

If the animation is paused when the button is pushed, the time-
code will be reset to 0:00 and the animation will be started.

Help

Press this button to display the 3D Flag Help in a web browser.

Cancel

Press this button to close the Options window without saving the 
values of the flag parameters.

OK

Press this button to close the Options window and accept the 
changes to the parameters. A new flag will be created based on 
the new values in the Options window.

The following parameters are used to build the flag:
	 • 	Flag Weight
	 • 	Flag Stretch
	 • 	Flag Bend
	 • 	Flag Shear
	 • 	Conform
	 • 	Air Friction
	 • 	Meshing Style
	 • 	Horizontal Mesh
	 • 	Vertical Mesh
	 • 	Motion Blur Steps (used when motion blur is active)
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Troubleshooting

 When I make a change it takes a long time for the 
flag to update.

The 3D Flag software is creating a physics-based simulation of a 
real world event. When a flag flaps the parts of the flag all interact 
with each other. This means that something that happens at the 
beginning of the animation will affect the flapping that occurs at 
the end of the animation.

When you change a parameter it causes the whole animation to 
change, so the whole animation has to be recalculated. If your 
time marker (or play head) is sitting at the beginning of the 
animation there is not a lot of recalculating that needs to be done 
in order to show you the flag at the current time. However if 
your time marker is sitting well into the animation then all of the 
frames between time 0 and the current time need to be recalcu-
lated before the flag can be rendered.

The solution for the time lag you are experiencing is to move the 
time marker (play head) to time 0:00 or frame 1. Then changes 
will take the least possible amount of time.

 Why is there black around the flag poles?

You are looking at the animation in draft mode. You need to ren-
der in Best Quality to make the black disappear from around the 
flag poles.


